
M�  �� U 

 Giáo trình thi� t k�  web dành cho ng�� i khi� m thính ��� c xây d� ng d� a trên nhu c� u 

thi� t y� u c� a ng�� i khi� m thính trong khuôn kh	  � ào t
 o CNTT cho ng�� i khuy� t t� t thu� c 

“D�  án Ch�
 ng trình � ào t
 o Công ngh�  thông tin cho Ng�� i khuy� t t� t” gi� a Tr�� ng Trung 

c� p K�  thu� t Tin h� c Hà N� i (ESTIH) và T	  ch� c c� u tr�  phát tri� n Qu� c t�  Hoa k�  (CRS) 

v� i s�  tài tr�  c� a C
  quan h� p tác phát tri� n Qu� c t�  Hoa k�  (USAID). 

 N� i dung chính c� a giáo trình: 

  + Lý thuy� t v�  HTML: (Kèm theo �� a CD) 

  + Xây d� ng website s�  d� ng b�  mã ngu� n m�  NukeViet 

  + Xây d� ng k�ch b� n web, thi� t k�  banner, logo, menu, hình � nh intro, qu� ng cáo.. 

  + Thi� t k�  � nh �� ng, file flash. 

 M� c tiêu c� a ch�
 ng trình: sau khi h� c xong ch�
 ng trình ng�� i h� c có th�  t
 o ��� c 

m� t k�ch b� n website hoàn ch nh, xây d� ng ��� c m� t website, ch nh s� a, qu� n tr� và �� a 

website lên m
 ng internet. 

 Trong tài li� u này có s�  d� ng thông tin tham kh� o, trích d� n t�  các tài li� u h�� ng d� n 

h�  th	 ng c
 a Nukeviet trên trang web www.nukeviet.vn. 

------- * ------ 
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I: M � T S�  KHÁI NI � M & CÀI �
 T CH�� NG TRÌNH 

1. M� t s�  khái ni� m 
a, Web page 
 Web page là m� t trang trong m� t web site, có th�  là m� t trong s�  các lo
 i trang sau: 

- *.HTML ho! c *.HTM (Hyper Text Markup Language): là m� t trang v"n b� n HTML 

bao g� m các th# (Tage) HTML và mã JavaScript (n� u có). 

- *.ASP (Active Server Page): là trang web g� m mã HTML và mã l� p trình b$ng 

ngôn ng�  VBScript (VBA) ho! c JavaScript (C) ��  l� p trình � i� u khi� n hay sinh mã 

HTML t% các câu l� nh, vòng l! p, thông tin t% c
  s�  d�  li � u ..v.v. 

- *.PHP (Hypertext Processor): là trang web g� m mã HTML và ngôn ng�  l� p trình 

b$ng mã JavaScript (C) ��  l� p trình � i� u khi� n hay sinh mã HTML t% các câu l� nh, 

vòng l! p, thông tin t% c
  s�  d�  li � u ..v.v. 

- *.ASPX (ASP.NET): là trang web ��� c thi� t k�  b$ng công ngh�  .NET (có th�  l
 p 

trình b� ng mã VBScript ho� c JavaScript). 

b, Website 
 Là toàn b�  m� t website hoàn ch nh g� m c�  các trang web và th�  vi� n kèm theo ��� c 

g� i là m� t website ho! c web project, g� m nhi� u web page. 

c, HTML (Hyper Text Markup Language) 
 Là ngôn ng�  do Tim Berners Lee ng�� i M�  phát minh n"m 1989 nh$m �� nh d
 ng thông 

tin trên d�ch v�  World Wide Web (WWW), s�  d� ng các th# (Tag) ��  �� nh d
 ng v"n b� n. 

d, Th�  HTML (Tag) 
 Dùng �� nh d
 ng cho v"n b� n HTML g� m: 

– Th# m� : <Tên th#> 

– Th# � óng: </Tên th#> 

– Th# �� y �� : <Tên th#> .......... </Tên th#> 

• VD: <Title> Tiêu ��  trang</Title> 

(Thi� t l
 p tiêu ��  c
 a m� t trang web) 

– Th# r&ng: <Tên th#> .......... </Tên th#> 

• VD: <BR> 

(Xu	 ng dòng v� n b� n v� i kho� ng cách 1 dòng – dòng �� n) 

�  Ghi chú: �� c thêm tài li� u v�  các lo� i th�  HTML và thu� c tính c
 a t� ng th�  trên website 

http://estih.edu.vn/tkweb. 
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2. C� u trúc c�  b� n c� a trang web 
 M� t trang web hay còn g� i là trang v"n b� n HTML dù là HTML, HTM, ASP, PHP hay 

ASPX �� u tuân th�  theo c� u trúc sau: 

 

3. T� i, cài �� t và thi� t l � p website trên Macromedia Dreamweaver 
a, T� i, cài �� t Macromedia Dreamweaver 
 Ph� n m� m Macromedia Dreamweaver là ph� n m� m giúp ta xây d� ng trang web �  c�  

ch�  ��  biên so
 n mã HTML và ch�  ��  thi� t k�  (Design) (1), �  ch�  ��  thi� t k�  ta th� c hi� n các 

l� nh chèn và �� nh d
 ng �� i t�� ng trong trang web ph� n m� m s'  t�  �� ng biên d�ch thành mã 

HTML, ngoài ra Dreamweaver còn h& tr�  t
 o trang web v� i t� t c�  các d
 ng file (m� c 1-a) và 

tích h� p k� t n� i v� i CSDL. 

B�  cài �! t ph� n m� m Dreamweaver có th�  t� i v�  t% website http://macomedia.com ho! c 

(t% �� a CD kèm theo) . Sau khi t� i b�  cài �! t v�  máy, ch
 y file cài �! t và làm theo h�� ng d(n, 

nh)p ch� n nút Next cho �� n khi ti� n trình cài �! t k� t thúc (ch� n Finish). 

*�  kh� i �� ng ch�
 ng trình ch� n: Start -> Programs -> Macromedia -> Macromedia 

Dreamweaver MX 2004. 

 bi� u t�� ng và tên g� i c� a ph� n m� m Macromedia 

Dreamweaver MX 2004 sau khi � ã cài �! t lên máy tính. 

 

�  Ghi chú: Trong tài li� u này s�  d� ng ph� n m� m Macromedia Dreamweaver MX 2004, hi� n 

nay � ã có phiên b� n cao h� n (chi ti� t xem t� i website http://macromedia.com). 
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Màn hình làm vi� c c� a Macromedia Dreamweaver MX 2004 

 

1- Thành công c� : ��� c s)p x� p thành các tab theo nhóm �� i t�� ng 

2- Ch�  ��  hi� n th� v"n b� n c� a trang web 

+ Code: hi� n th� v"n b� n d
 ng mã HTML 

+ Split: chia thành 2 c� a s	 : mã HTML và c� a s	  thi� t k�  (Design) 

+ Design: ch�  ��  thi� t k�  (1) 

3- N� i dung chính c� a trang web 

4- C� a s	  thu� c tính c� a �� i t�� ng (thay �� i theo t� ng �	 i t�� ng ��� c ch� n) 

5- Danh sách các file, folder có trong website 

b, Thi� t l� p website trên Dreamweaver MX 2004 
 T% c� a s	  làm vi� c c� a Dreamweaver ch� n m� c Manager Site -> New -> Site 

 

1 

2 

3 

4 
5 

1 

3 

2 
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 Xu� t hi� n c� a s	  Site Definitiion, ch� n tab Advanced và � i� n �� y ��  thông tin theo th�  

t�  nh�  hình v'  d�� i � ây. 

 

Ghi chú: Nh)p chu� t lên bi� u t�� ng Browse  ��  ch� n �� n th�  m� c ch� a website ho! c th�  

m� c Images, n� u th�  m� c ch� a t� n t
 i ta có th�  t
 o th�  m� c m� i ngay trên c� a s	  Browse. 

 Sau khi nh)p ch� n nút OK ��  k� t thúc ta có màn hình làm vi� c nh�  sau: 

 

*�  m�  trang web trên trình duy� t chon File -> Prewview in Browser (F12) ho! c bi� u 

t�� ng Prewview in Browser  (hình qu�  c� u internet) trên thanh l� a ch� n ch�  ��  hi� n th� c� a 

trang. 
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*�  thêm m� t trang web ch� n File -> New -> xu� t hi� n c� a s	  sau: 

 

Ch� n nhóm ki� u file trong m� c Category (1), ch� n ki� u file trong ô bên ph� i (1) r� i 

ch� n nút Create.  

- Basic page: T
 o trang web tính 

- Dynamic page: T
 o trang web �� ng 

- Template pagr: T
 o trang web theo m(u 

- Other: T
 o trang theo quy �� nh khác 

- CSS Style Sheet: T
 o trang �� nh d
 ng ki� u 

- Framesets: T
 o trang b�  c� c d
 ng Frame 

*� n � ây ta l� a ch� n ki� u hi� n th� c� a trang và so
 n th� o n� i dung c� a trang web c� n 

xây d� ng. 

1 2 
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II: THI � T K �  TRANG WEB T � NH 

1. Thi� t k�  c� u trúc website 
Tr�� c khi thi� t k�  m� t website vi� c �� u tiên ng�� i thi� t k�  ph� i xác �� nh � ó là c� u trúc 

cho toàn b�  website s'  ��� c thi� t k� : b�  c� c g� m m� y ph� n? ��� c ph� n chia khu v� c c� a 

t%ng ph� n nh�  th�  nào? ….v.v. 

D�� i � ây tác gi�  xin �� a ra m� t s�  m(u thi� t k�  website th�� ng dùng nh�  sau: 

M(u 1: 

 

M(u 2: 
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M(u 3: 

 

M(u 4: 

 

Tuy nhiên các m(u trên � ây ch  mang tính tham kh� o, vi� c l� a ch� n c� u trúc c� n ph� i 

��� c s�  th+a thu� n v� i bên yêu c� u xây d� ng website. 

*�  b�  trí ��� c b�  c� c cho website, ph� n vùng …v.v h� u h� t ph� i s�  d� ng b� ng (Table) 

��  b�  c�  cho web. 
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2. Xây d� ng m� t trang web �� n gi� n 
a, T� o b� ng trong trang web 

C1: *�  chèn m� t 

b� ng vào trang web 

tr�� c h� t ta ch� n v� trí 

c� n chèn, ch� n Insert -> 

Table  ho! c nh� n t	  h� p 

phím Ctrl + Alt + T 

C2: S�  d� ng bi� u 

t�� ng Table  trên 

thanh công c� . 

Thi� t l� p các 

thông s�  cho b� ng s)p 

��� c chèn r� i nh)p 

ch� n nút OK ��  k� t 

thúc. 

 

 

 

 + Rows: S�  l�� ng hàng (dòng) 

 + Columns: S�  l�� ng c� t 

 + Table width: *�  r� ng c� a b� ng 

  - Kích th�� c c�  �� nh ��� c �! t b$ng �
 n v� pixels 

  - Kích th�� c t,  l�  v� i �� i t�� ng ch� a nó �! t �
 n v� tính là percent (%) 

(N� u là ��  r� ng c
 a c�  trang web th�� ng �� t b� ng 1000 pixels ho� c 100 percent - %) 

 + Border thickness: Kích th�� c c� a ��� ng vi� n (n� u mu	 n ��� ng vi� n không hi� n th� 

thì �� t kích th�� c c
 a ��� ng vi� n = 0) 

 + Cell padding: Kho� ng cách t% vi� n c� a ô �� n v"n b� n trong ô 

 + Cell spacing: Kho� ng cách gi� a vi� n trong và vi� n ngoài c� a ô 

* Thu � c tính c� a b� ng 

 *�  thi� t l� p thu� c tính c� a b� ng ta ph� i ch� n b� ng ��  c� a s�  Properties xu� t hi� n các 

thu� c tính c� a b� ng � ang ch� n. 
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- Vùng 1: Các thông s�  gi� ng nh�  khi t
 o b� ng 

- Vùng 2: Bao g� m các thu� c tính 

o Bg color: Màu n� n c� a b� ng 

o Brdr color: Màu ��� ng vi� n c� a b� ng 

o Bg Images: S�  d� ng hình � nh làm n� n cho b� ng 

* Thu � c tính c� a ô 

 Thu� c tính c� a ô dùng ��  quy �� nh các �� nh d
 ng cho ô và d�  li � u trong ô, mu� n thay 

�	 i thu� c tính c� a ô tr�� c tiên c� n ch� n ô c� n thay �	 i ��  c� a s	  Properties hi� n th� các thu� c 

tính c� a ô � ó. 

 

- Vùng 1: Các thu� c tính �� nh d
 ng cho v"n b� n trong ô � ang ch� n 

- Vùng 2: Các thu� c tính �� nh d
 ng cho ô � ang ch� n 

o Horz: Canh v"n b� n trong ô theo chi� u ngang 

o Vert: Canh v"n b� n trong ô theo chi� u d� c 

(Các thu� c tính còn l� i gi	 ng nh�  thu� c tính trong vùng 2 c
 a b� ng) 

* Tr � n (hòa nh� p) các ô 

 Trong khi thi� t k�  ta th�� ng ph� i tr� n các ô thành m� t, ��  th� c hi� n vi� c này ta ch� n 

các ô c� n tr� n (bôi � en các ô) r� i th� c hi� n thao tác sau: 

 Ch� n ph� i chu� t t
 i các ô � ã ch� n -> Table -> Mage cells 

* Tách m� t ô thành nhi� u ô 

 *�  tách m� t ô thành nhi� u ô ta 

th� c hi� n các thao tác sau: 

 Ch� n ph� i chu� t trong ô -> 

Table -> Split cell 

 Ch� n ki� u tách theo dòng (rows) 

ho! c theo c� t (columns) và nh� p s�  ô c� n tách r� i ch� n nút OK. 

1 

2 

1 

2 
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b. �	 nh d� ng v
 n b� n 
 *�  �� nh d
 ng v"n b� n trong trang web ta ch� n kh� i v"n b� n c� n �� nh d
 ng r� i thay �	 i 

thu� c tính c� a kh� i v"n b� n trong c� a s	  Properties. 

 

- Paragraph: *� nh d
 ng v"n b� n thành tiêu �� , g� m 6 m� c tiêu ��  t% Heading 1 �� n 

Heading 6. 

- Font: *� nh d
 ng font ch�  cho v"n b� n 

- Style: *� nh d
 ng theo quy �� nh riêng 

- Size: Ch� n c-  ch� , k�  ti� p là màu ch�  

- Ch� n các ki� u canh l�  cho v"n b� n, danh sách có th�  t� , không có th�  t�  …v.v. 

c. T� o liên k� t cho �� i t�
 ng trong trang web 
 Liên k� t (Hyper link) là vi� c t
 o ra b�� c nh� y trong trang web, � ây là m� t � i� m m
 nh 

và ��� c s�  d� ng r� t nhi� u trong m� i trang web, liên k� t có th�  ��� c thi� t l� p t% m� t � o
 n v"n 

b� n ho! c m� t hình � nh trong trang web. Có th�  ��� c liên k� t t� i m� t v� trí trong cùng m� t 

trang, m� t trang trong cùng m� t website, t� i m� t trang web khác ho! c m� t �� a ch  email…v.v. 

 *�  t
 o liên k� t cho �� i t�� ng ta ch� n �� i t�� ng � ó r� i thanh �	 i thu� c tính trong c� a s	  

Properties t
 i các thu� c tính sau: 

 

- Link: Là �� a ch  ��� c liên k� t t� i 

o *�  liên k� t t� i m� t trang khác trong website ch� n bi� u t�� ng Browse r� i 

ch� n trang c� n liên k� t t� i 

o *�  liên k� t �� n m� t trang web khác ta nh� p �� a ch  c� a nó trong ô Link 

o *�  liên k� t �� n m� t � ia ch  email ta nh� p: mailto:�� a ch  mail 

- Target: C� a s	  s'  ��� c m�  liên k� t 

o _blank: M�  t
 i m� t c� a s	  m� i 

o _parent: T
 i c� a s	  hi� n th� i 

o _left, _top: Ch  áp d� ng cho Frame 
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d. Chèn hình � nh vào trang web 
 *�  �� m b� o khi website ��� c copy �� n n� i khác ho! c �� a lên internet không b� thi� u 

hình � nh thì toàn b�  hình � nh ph� i �! t trong website (trong th�  m� c Images). *�  chèn hình 

� nh vào trang web nh�  sau: 

- Ch� n v� trí c� n chèn hình � nh 

- Ch� n Insert -> Images 

- Ch� n ��� ng dãn �� n hình � nh c� n chèn r� i nh)p ch� n nút OK 

�  Ghi chú: N� u hình � nh ch� a ��� c �� t trong website thì ch�� ng trình s�  t�  �� ng copy hình 

� nh t� i th�  m� c g	 c c
 a website. Vì v
 y ��  �� m b� o cho hình � nh � ã có trong website m� t 

cách có t�  ch� c ta c� n copy hình � nh vào th�  m� c Images tr�� c khi chèn, �� n � ây ta ch� vi� c 

kéo hình � nh trong th�  m� c Images t�  m� c Files trong panel ph� i �� n v� trí c� n. 

* Thu � c tính c� a hình � nh 

 *�  thay �	 i thu� c tính c� a hình � nh ta c� n ph� i ch� n hình � nh � ó ��  thu� c tính c� a hình 

� nh ��� c hi� n th� trong c� a s	  Properties. 

 

- W; *�  r� ng c� a hình � nh; H: Chi� u cao c� a hình � nh 

- Src: File ngu� n c� a hình � nh 

- Link: *� a ch  mà hình � nh s'  liên k� t t� i 

- Alt: N� i dung s'  ��� c hi� n th� nh�  là thông báo khi di chu� t �� n hình � nh 

- V Space: Kho� ng cách trên và d�� i c� a hình � nh 

- H Space: Kho� ng cách bên trái và bên ph� i c� a hình � nh 

- Align: Canh l�  cho hình � nh, l� a ch� n v� trí c� a hình � nh v� i v"n b� n ..v.v. 

VD; *�  hình � nh và v"n b� n ��� c hi� n th� nh�  sau ta c� n ch� n m� c Align=left 
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e, Chèn âm thanh, video, flash vào trang web 
 *�  chèn �� i t�� ng media vào trang web ta ch� n v� trí c� n chèn r� i th� c hi� n các thao 

tác sau: 

- Ch� n Insert -> Media 

- Ch� n m� c t�
 ng � ng v� i ki � u file media ngu� n mu� n chèn 

�  Ghi chú: C ng gi	 ng nh�  chèn hình � nh, file media ��� c ch� n s�  t�  �� ng ��� c copy vào 

th�  m� c g	 c c
 a website. 

 

f, Xây d� ng website �� n gi� n 
 Giáo viên h�� ng d(n xây d� ng website theo m(u có s. n. 

Bài t� p th� c hành trong �� a CD kèm theo giáo trình 
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III: S �  D� NG FTP FILEZILA CLIENT 

1. T� i và cài �� t Ftp FileZila Client 
 Ftp FileZila Client là ph� n m� m mi/ n phí h& tr�  k� t n� i t� i d�ch Ftp, b
 n có th�  t� i v�  t% 

website c� a nhà d�ch v�  theo �� a ch : http://filezilla-project.org/download.php?type=client 

 ho! c b�  cài �! t trong �� a CD kèm theo giáo trình. 

 Sau khi t� i v�  b
 n hãy ch
 y t� p tin Setup này ��  cài �! t. Cách cài �! t FileZilla Client 

c0ng gi� ng nh�  các ch�
 ng trình khác, b
 n l� n l�� t ch� n I Agree ��  ch� p nh� n � i� u ki� n s�  

d� ng c� a FileZilla Client , gi�  nguyên các thi� t l� p m! c �� nh c� a ch�
 ng trình, 

nh� n Next theo h�� ng d(n và nh� n Install  ��  cài �! t. 

2. Truy c� p t� i FTP b� ng FTP FileZila Client 
 Sau khi cài �! t, ch
 y ch�
 ng trình FTP FileZila Client và nh� p các thông s�  k� t n� i t� i 

hosting nh�  sau (théo th�  t�  t�  trái sang ph� i): 

 

- Máy ch� : Là tên domain ho! c �� a ch  IP ho! c �� a ch  Ftp c� n truy c� p t� i 

- Tên tài kho� n: Là tài kho� n Ftp ��  truy c� p t� i hosting 

- M� t kh1u: Là m� t kh1u truy c� p t� i hosting 

1 3 

4 2 

5 
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- C	 ng: N� u FTP Server thi� t l� p c	 ng riêng thì ta c� n nh� p thông tin v�  công (��  

tr	 ng thì ch�� ng trình s�  nh
 n giá tr� m� c �� nh là c� ng 21). 

Sau khi k� t nôi ta thu ��� c màn hình làm vi� c c� a FTP FileZila Client nh�  hình trên  

- (1)- C� a s	  qu� n lý t� p tin trên máy tính cá nhân 

- (2)- Danh sách các file và folder có trong th�  m� c ��� c ch� n �  c� a s	  (1) 

- (3)- C� a s	  qu� n lý t� p tin c� a th�  m� c trên hosting 

- (4)- Danh sách các file và folder có trong th�  m� c ��� c ch� n �  c� a s	  (3) 

- (5)- Th�  hi� n tr
 ng thái và ti� n trình th� c hi� n c� a quá trình tuy� n t� i file ho! c th�  

m� c gi� a máy tính cá nhân và hosting 

3. T� i website lên hosting 
* *�  t� i upload file ho! t folder lên 

hosting ta ch� n và kéo t% c� a s	  (2) sang c� a 

s	  (4) và ng�� i l 
 i ��  download t% hosting v�  

máy tính cá nhân ta kéo t% c� a s	  (4) sang 

c� a s	  (2). 

* *�  thay �	 i quy� n truy c� p c� a file 

ho! c folder ta ch� n file ho! c folder c� n thay 

�	 i trong c� a s	  (4) sau � ó th� c hi� n theo các 

b�� c sau: 

 - Ch� n ph� i hu� t trên file ho! c 

folder � ã ch� n -> Quy� n truy c� p … 

 - L� a ch� n quy� n th� c thi cho �� i 

t�� ng r� i ch� n nút *� ng ý ��  k� t thúc. 
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IV: CÀI �
 T, S�  D� NG VÀ QU� N TR  NUKEVIET 
 

NukeViet là m� t h�  qu� n tr� n� i dung (Content Management System - CMS) cho phép 

b
 n qu� n lý các c	 ng thông tin � i� n t�  trên Internet. Nói �
 n gi� n, NukeViet gi� ng nh�  m� t 

ph� n m� m giúp b
 n xây d� ng và v� n hành các trang web c� a mình m� t cách d/  dàng nh� t. 

Website b
 n � ang xem - trang nukeviet.vn này - ��� c t
 o ra và v� n hành b� i ph� n m� m 

NukeViet. 

NukeViet là m� t ph� n m� m mã ngu� n m� , do � ó vi� c s�  d� ng hoàn toàn mi/ n phí, b
 n 

có th�  t� i NukeViet v�  b� t c�  lúc nào t
 i website chính th� c c� a NukeViet là nukeviet.vn. B
 n 

có th�  cài NukeViet lên hosting ��  s�  d� ng ho! c c0ng có th�  th�  nghi� m b$ng cách cài ngay 

lên máy tính cá nhân. 

NukeViet cho phép xây d� ng m� t website �� ng, � a ch� c n"ng, hi� n �
 i m� t cách nhanh 

chóng mà ng�� i v� n hành nó th� m chí không c� n ph� i bi� t m� t tí gì v�  l� p trình b� i t� t c�  các 

tác v�  qu� n lý ph� c t
 p �� u ��� c t�  �� ng hóa �  m� c cao. NukeViet �! c bi� t d/  dàng s�  d� ng 

vì hoàn toàn b$ng ti� ng Vi� t và ��� c thi� t k�  phù h� p nh� t v� i thói quen s�  d� ng m
 ng c� a 

ng�� i Vi � t Nam. 

B$ng vi� c s�  d� ng các công ngh�  web m� i nh� t hi� n nay, thi� t k�  h�  th� ng uy� n chuy� n 

và s�  h� u nh� ng tính n"ng �� c � áo, NukeViet s'  giúp b
 n tri� n khai các � ng d� ng web t% nh+ 

�� n l� n m� t cách nhanh chóng và ti� t ki� m: t% các website cá nhân cho t� i các c	 ng thông tin 

� i� n t� ; t% các gian hàng tr� c tuy� n cho t� i các m
 ng xã h� i... 

NukeViet là CMS mã ngu� n m�  �� u tiên c� a Vi� t Nam có quá trình phát tri� n lâu dài 

nh� t, có l�� ng ng�� i s�  d� ng � ông nh� t. Hi� n NukeViet c0ng là m� t trong nh� ng mã ngu� n 

m�  chuyên nghi� p �� u tiên c� a Vi� t Nam, c
  quan ch�  qu� n c� a NukeViet 

là VINADES.,JSC - �
 n v� ch�u trách nhi� m phát tri� n NukeViet và tri� n khai NukeViet 

thành các � ng d� ng c�  th�  cho doanh nghi� p. 

*�  ch
 y h�  th� ng NukeViet trên Internet c� n �" ng ký gói hosting có h& tr�  ngôn ng�  

PHP, c
  s�  d�  li � u MySql (t	 t nh! t là l� a ch� n gói hosting ch� y trên h�  � i� u hành linux) 

*�  ch
 y h�  th� ng NukeViet trên máy tính cá nhân c� n cài �! t máy tính cá nh� n c� a b
 n 

thành m� t máy ch�  web có ��  các � i� u ki� n trên (nên cài �� t ph� n m� n Vertrigo ho� c 

XAMPP làm d�ch v�  cho máy ch
  web). 

Trong tài li� u này s'  h�� ng d(n cài �! t và s�  d� ng h�  thông NukeViet 3.0 c�  trên máy 

tính cá nhân và trên hosting. 
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NukeViet 3.0 là th�  h�  CMS hoàn toàn m� i do ng�� i Vi � t phát tri� n. L� n �� u tiên �  

Vi � t Nam, m� t b�  nhân mã ngu� n m�  ��� c �� u t�  bài b� n và chuyên nghi� p c�  v�  tài chính, 

nhân l� c và th� i gian. K� t qu�  là 100% dòng code c� a NukeViet ��� c vi� t m� i hoàn toàn, 

NukeViet 3 s�  d� ng xHTML, CSS v� i Xtemplate và jquery cho phép v� n d� ng Ajax uy� n 

chuy� n c�  trong công ngh�  nhân. 

T� n d� ng các thành t� u mã ngu� n m�  có s. n nh� ng NukeViet 3 v(n �� m b� o r$ng t%ng 

dòng code là ��� c code tay. * i� u này có ngh�a là NukeViet 3 hoàn toàn không l�  thu� c vào 

b� t c�  framework nào trong quá trình phát tri� n c� a mình; B
 n hoàn toàn có th�  �� c hi� u ��  

t�  l� p trình trên NukeViet 3 n� u b
 n bi� t PHP và MySQL (�� ng ngh�a v� i vi � c NukeViet 3 

hoàn toàn m�  và d/  nghiên c� u cho b� t c�  ai mu� n tìm hi� u v�  code c� a NukeViet).Gi� i thi� u 

và cài �! t NukeViet 3 Trang 4 

B�  nhân NukeViet 3 ngoài vi� c th%a h�� ng s�  �
 n gi� n v� n có c� a NukeViet nh� ng 

không vì th�  mà quên nâng c� p mình. H�  th� ng NukeViet 3 h& tr�  công ngh�  � a nhân module. 

Chúng tôi g� i � ó là công ngh�  � o hóa module. Công ngh�  này cho phép ng�� i s�  d� ng có th�  

kh� i t
 o hàng ngàn module m� t cách t�  �� ng mà không c� n �� ng �� n m� t dòng code. Các 

module ��� c sinh ra t% công ngh�  này g� i là module � o. Module � o là module ��� c nhân b� n 

t% m� t module b� t k�  c� a h�  th� ng nukeviet n� u module � ó cho phép t
 o module � o. 

NukeViet 3 c0ng h& tr�  vi� c cài �! t t% �� ng 100% các module, block, theme t% Admin 

Control Panel, ng�� i s�  d� ng có th�  cài module mà không c� n làm b� t c�  thao tác ph� c t
 p 

nào. NukeViet 3 còn cho phép b
 n � óng gói module ��  chia s# cho ng�� i khác. 

NukeViet 3 � a ngôn ng�  100% v� i 2 lo
 i: � a ngôn ng�  giao di� n và � a ngôn ng�  

database. NukeViet 3 có tính n"ng  cho phép ng�� i qu� n tr� t�  xây d� ng ngôn ng�  m� i cho 

site. Cho  phép � óng gói file ngôn ng�  ��  chia s# cho c� ng �� ng... câu chuy� n v�  nukeviet 3 

s'  còn dài vì m� t lo
 t các tính n"ng cao c� p v(n � ang ��� c phát tri� n. Hãy s�  d� ng và ph	  

bi� n NukeViet 3 ��  t�  mình t� n h�� ng nh� ng thành qu�  m� i nh� t t% công ngh�  web mã 

ngu� n m� . 

1. Vertrigo 
a, Gi� i thi � u 

Vertrigo là ph� n m� m t
 o máy ch�  web (localhost) dùng cho máy tính cá nhân ��  ch
 y 

mã ngu� n PHP, vertrigo hi� n ��� c s�  d� ng r� ng rãi và có kh�  n"ng t�
 ng thích v� i m� i h�  

� i� u hành. 

Sau khi cài �! t Vertrigo b
 n s'  có: Appache, PHP, MySql, Smarty, SQLite, 

PhpMyadmin, SqliteMagager, ZenOptimizer. 
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Phiên b� n ��� c s�  d� ng minh h� a trong tài li� u này là b� n Vertrigo 2.21 phát hành ngày 

9 tháng 7 n"m 2008. 

T� i v�  theo �� a ch : http://vertrigo.sourceforge.net ho! c s�  d� ng b�  cài �! t trong � ãi CD 

b, Cài �� t 
- B�� c 1: Ch
 y file cài �! t Vertrigo_221.exe, l� a ch� n ngôn ng�  cài �! t r� i ch� n OK. 

 

- B�� c 2: C� a s	  chào m� ng hi� n ra, nh� n Next ��  ti� p t� c 

- B�� c 3: C� a s	  gi� y phép s�  d� ng hi� n ra, nh� n I Agree ��  ti� p t� c 

- B�� c 4: Ch� n thành ph� n cài �! t (nên ��  m� c � inh), nh� n Next ��  ti� p t� c 

- B�� c 5: Ch� n th�  m� c cài �! t (ch� n D:\VertrigoServ) nh� n Next ��  ti� p t� c 

- B�� c 6: Nh� n Next, nh� n Install ��  ch�
 ng trình ti� n hành cài �! t 

- B�� c 7: Ch�
 ng trình cài �! t k� t thúc, nh� n Close ��  � óng c� a s	  cài �! t 

- B�� c 8: Nh� n Finish ��  k� t thúc quá trình cài �! t và ch
 y ch�
 ng trình 

Sau khi ch� n ��  ch
 y ch�
 ng trình, c� a s	  kh� i �� ng xu� t hi� n, ch� n “Hide this 

window and start server” ��  b) t �� u ch
 y 

 

 K� t thúc cài �! t và ch
 y ch�
 ng trình, ch� n bi� u t�� ng  c� a ch�
 ng trình ta có h�  

th� ng menu chính c� a Vertrigo nh�  hình d�� i �� y. 
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IP c� a máy tính 

* i� u khi� n ho
 t �� ng c� a web server 

Các công c�  nh� : PhpMyadmin, SQLiteMagager 

C� u hình web server 

S�  ki� n log in 

Tài li� u h�� ng d(n 

Xu� t ch�
 ng trình 

Trang web c� a nhà d�ch v�  

Trang tr�  giúp 

Trang web localhost 

Th�  m� c ch� a website 

Thi� t l� p thông s�  cho server 

T) t và thoát kh+i ch�  ��  làm vi� c c� a máy ch�  web 

Phiên b� n hi� n th� i 

- Toàn b�  website ��� c �! t trong th�  m� c D:\Vertrigo\www 

- *" ng nh� p ��  qu� n tr� c
  s�  d�  li � u b$ng PhpMyadmin b$ng tài kho� n: 

o User Name: root 

o Password: vertrigo 

- Database ��� c �! t trong th�  m� c D:\Vertrigo\MySQL\data 

-  

�  Ghi chú: Tài li� u h�� ng d� n cài �� t, ch"nh s� a và qu� n tr� Vertrigo có trong m� c V� n b� n 

– Tài li� u trên website http://estih.edu.vn ho� c trong �#a CD kèm theo 

 

2. NukeViet 
a, T� i và cài �� t NukeViet 
* Yêu c� u máy ch�  

- H�  � i� u hành:  Unix (Linux, Ubuntu, Fedore...) ho! c Windows 

- PHP: PHP 5.2 ho! c phiên b� n m� i nh� t. 

- MySQL:  MySQL 5.02 ho! c phiên b� n m� i nh� t 

* Chu1n b� cho vi� c cài �! t 

1. T� i NukeViet 3 t% http://nukeviet.vn  

2. *�  có th�  cài �! t nukeviet 3 trên localhost b
 n c� n chu1n b� máy ch�  web trên  

máy tính c� a mình (b�� c này có h�� ng d� n chi ti� t t� i cài �� t Vertrigo). 

3. Gi� i nén n� i dung vào th�  m� c www trên localhost 

4. Ti� n hành cài �! t b$ng vi� c truy c� p �� a ch  website c� a b
 n, t� i th�  m� c b
 n � ã  

upload mã ngu� n NukeViet lên theo các b�� c sau: 
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B1. T� o c�  s�  d�  li � u r� ng 

C
  s�  d�  li � u r&ng th� c ch� t là m� t Database m� i. *�  t
 o m� t CSDL r&ng, b
 n th� c hi� n theo  

trình t�  sau: 

- M�  trình duy� t web, gõ http://localhost/phpmyadmin/ 

- *" ng nh� p b2ng tài kho� n: user name: root; password: vertrigo 

- T
 i ô Create new database, nh� p tên c
  s�  d�  li � u mà b
 n mu� n t
 o m� i.  

o Ví d� : “Nuke”. Nh� p Create 

B2. Th� c hi� n cài �	 t 

 *�  th� c hi� n cài �! t ta truy c� p �� a ch  website t� i th�  m� c NuketViet (locaohost), h�  

th� ng s'  t�  �� ng kích ho
 t ��  ti� n hành cài �! t. 

 - L� a ch� n ngôn ng�  cài �! t: 

 
Nh� n ch� n nút “B�� c k�  ti� p” ��  chuy� n sang b�� c ti� p theo 

- Nh� n ch� n nút “B�� c k�  ti � p” ��  xác �� nh th+a thu� n v�  b� n quy� n và chuy� n sang 

quá trình ki� m tra tr
 ng thái c� a h�  th� ng 

- Nh� n ch� n nút “B�� c k�  ti � p” 2 l� n n� a ��  sang c� p nh� t thông tin v�  c
  s�  d�  li � u 

cho h�  th� ng (ta ph� i t� o c�  s$ d% li � u tr	 ng-B1 tr�� c khi th� c hi� n b�� c ti� p theo). 

- Nh� p thông tin c� u hình cho c
  s�  d�  li � u r� i ch� n nút “Th� c hi� n” 

 

vertrigo 
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- Nh� p thông tin cho h�  th� ng website, nh� n ch� n nút “Th� c hi� n” 

 

 
 

- Sau khi nh� n ch� n nút “Th� c hi� n” �  b�� c trên h�  th� ng t�  �� ng cài �
 t, n� u không 

thông tin ��� c th+a mãn thì quá trình cài �! t k� t thúc, h�  th� ng s'  thông báo: 

 

 
 

- Nh� n ch� n “Xem trang ch� ” ��  v�  trang web, “�� ng nh	 p trang qu
 n tr �” ��  

truy c� p vào trang qu� n tr� c� a h�  th� ng. 

 

*� n � ây vi� c cài �! t c� a b
 n � ã thành công, h�  th� ng � ã có s. n m� t s�  tin bài ��  cho 

b
 n th�  nghi� m. Hãy ch� n nút “Xem trang ch� ” ��  hi� n th� website c� a mình ho! c truy c� p 

�� a ch  website mà ta th� c hi� n cài �! t, b�  c� c và toàn c� nh c� a trang website ��� c mình h� a 

theo hình d�� i � ây. 

123456 
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b, H�� ng d� n qu� n tr	 tin t� c 
*" ng nh� p trang qu� n tr� theo �� a ch  http://yourdomain/admin (http://locaohost/admin) 

ta có màn hình �" ng nh� p nh�  hình d�� i � ây. 

*" ng nh� p b$ng tài kho� n � ã thi� t 

l� p �  ph� n cài �! t: 

User name: Admin  

Password: 123456 

Ch� n nút �" ng nh� p ��  vào trang 

qu� n tr�, n� u quên m� t kh1u b
 n click 

chu� t vào link “Quên m� t kh1u” ��  th� c 

hi� n vi� c khôi ph� c l
 i m� t kh1u. 

Sau khi �" ng nh� p thành công, ch� n 

m� c “Tin t � c” ta có màn hình qu� n tr� chính nh�  sau: 

 
*�  có th�  xu� t b� n m� t bài vi� t tr�� c tiên chúng ta c� n ph� i t
 o: Ch�  �� , Chuyên ��  và 

Ngu� n tin cho bài vi� t.  

* Ch�  ��  và qu� n lý ch�  ��  tin t � c  

Ch�  ��  cho phép ta �� a b� n tin vào trong � ó t
 o thành m� t chuyên m� c tin t� c, bao g� m 

nhi� u bài vi� t liên quan bên trong.  


�  thêm m� i m
 t ch�  ��  tin t� c chúng ta c� n ph� i qua 04 b�� c:  

- B�� c 1: Nh� p vào tiêu �� .  

- B�� c 2: Ch� n ch�  ��  (Khi l� n �� u tiên thêm m� i m� t ch�  ��  m! c �� nh nó ��� c ch� n là 

ch�  ��  chính, �  nh� ng l� n thêm ti� p theo các b
 n có th�  ch� n ch�  ��  � ó là ch�  ��  chính ho! c 

là thành ph� n con).  

- B�� c 3: Nh� p vào t% khóa cho ch�  ��  (Nh$m t
 o ra ph� n meta keyword cho ch�  �� , 

nh�  th�  các b�  máy tìm ki� m s'  phân lo
 i và � ánh giá ch�  ��  - có l� i v�  k� t qu�  tìm ki� m cho 

website c� a b
 n).(Có th�  nh� p ho! c không)  

- B�� c 4: Nh� p vào ph� n miêu t�  ch�  ��  - ph� n này s'  ��� c thêm vào ph� n meta 

description  
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Sau khi hoàn thành 04 b�� c trên chúng ta nh� n vào nút: L� u thay �	 i. Nh�  v� y m� t ch�  

��  m� i � ã ��� c thêm. 

 

�  s� a m
 t ch�  ��  chúng ta c� n qua 05 b�� c:  

- B�� c 1: Nh� p l
 i tiêu ��   

- B�� c 2: Ch� n l
 i ch�  ��   

- B�� c 3: Nh� p liên k� t t�nh cho ch�  ��  - nh$m m� c � ích t
 o ra ��� ng d(n thân thi� n 

cho ch�  ��  và ��� c b�  máy tìm ki� m � u tiên trong k� t qu�  tìm ki� m. Ph� n này ch  xu� t hi� n 

khi s� a ch�  �� , sau khi b
 n thêm m� i ch�  ��  �� n khi s� a h�  th� ng � ã l� c t% và �� a ra g� i ý 

cho b
 n.  

- B�� c 4: Nh� p l
 i t% khóa  

- B�� c 5: Nh� p l
 i ph� n miêu t�  ch�  �� .  

Sau khi hoàn thành 05 b�� c bên trên thì nh� p vào nút L� u thay �	 i ��  c� p nh� t l
 i 

nh� ng thay �	 i cho ch�  �� . 

Danh sách các ch�  ��  và tr
 ng thái c� a nó ��� c th�  hi� n nh�  sau: 

 
(1). V� trí: Ch  ra v� trí s)p x� p c� a ch�  ��  so v� i các ch�  ��  khác. *�  thay �	 i v� trí c� a 

1 ch�  ��  các b
 n có th�  nh� n vào Menu l� a ch� n c� a ch�  ��  � ó.  

(2). Hi� n th� trang ch� :Có 02 l� a ch� n: Có ho! c Không, menu này cho phép ch�  ��  có 

th�  xu� t hi� n t
 i trang ch�  c� a site hay không.  

1 
2 

3 

4 
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(3). Cách th�  hi� n ch�  �� : *� i v� i t%ng ch�  ��  s'  có 06 l� a ch� n cách hi� n th� tin t� c 

trình bày cho ch�  ��  � ó:  

- Danh sách, m� i lên trên  

- Danh sách, c0 lên trên 

- Ch�  �� , tin khác n$m bên trái  

- Ch�  �� , tin khác n$m bên ph� i  

- Ch�  �� , tin khác n$m bên d�� i  

- Chia thành 02 c� t  

(4). S�  liên k� t: *� i v� i t%ng ch�  ��  cho phép ta ch� n s�  liên k� t thu� c ch�  ��  � ó giá tr� 

m! c �� nh s'  ��� c ch� n là 3.  

(5). Ch� c n"ng thêm dành cho ph� n qu� n lí ch�  ��  nh�  : Xóa – s� a ch�  �� , thêm bài vi� t 

m� i vào ngay ch�  ��  � ó.  

Khi xóa ch�  ��  c� n l� u ý nh� ng � i� u sau:  

- Khi ch�  ��  ch� a các thành ph� n – ch�  ��  con trong nó, h�  th� ng s'  không cho b
 n xóa 

ch�  ��  � ó. *�  có th�  xóa ��� c nó b
 n c� n ph� i di chuy� n các thành ph� n – ch�  ��  con trong 

chuyên m� c � ó 

 
Trong hình trên chúng ta có tiêu ��  “Tin t� c” có 3 chuyên m� c con trong nó là: Thông 

cáo báo chí, B� n tin n� i b� , tin công ngh� . *�  có th�  xóa ��� c chuyên m� c “Tin t� c” chúng ta 

ph� i vào bên trong nó – xóa ho! c s� a các chuyên m� c: Thông cáo báo chí, B� n tin n� i b� , tin 

công ngh� .  

- *�  minh h� a cho vi� c xóa 1 ch�  �� : Chúng ta s'  xóa ch�  �� : “Thông cáo báo chí” là 

ch�  ��  con c� a ch�  ��  “Tin t� c” nh�  d�� i � ây 

 
 3  hình trên sau khi nh� n vào ch� c n"ng xóa (1) h�  th� ng s'  thông báo cho chúng ta m� t 

h� p tho
 i ��  kh2ng �� nh ch)c ch)n r$ng b
 n mu� n xóa nó hay không? Sau khi nh� n OK h�  

th� ng s'  chuy� n b
 n sang b�� c ti� p theo nh�  hình d�� i � ây: 
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Vi � c xóa 1 chuyên m� c s'  làm m� t toàn b�  các d�  li � u và bài vi� t trong chuyên m� c � ó, 

��  �� m b� o vi� c an toàn d�  li � u cho b
 n – h�  th� ng yêu c� u b
 n c� n ph� i xác nh� n l
 i m� t l� n 

n� a vi� c “Xóa ch�  ��  và các bài vi� t”(B�� c 1) Ho! c di chuy� n ch�  ��  b$ng cách: L� a ch� n 

ch�  ��  tin t� c mu� n di chuy� n t� i (B�� c 2), khi l� a ch� n xong nh� n vào nút “Th� c hi� n” ��  

b) t �� u di chuy� n các bài vi� t bên trong chuyên m� c “T	 ng h� p” (B�� c 3). Sau khi hoàn 

thành – b
 n có th�  xóa ho! c s� a các ch�  ��  ti� p theo: Chi h� i, pháp lý. Khi hoàn t� t các b�� c 

� ó chúng ta m� i có th�  xóa ch�  ��  “Tin c� ng �� ng”.  

* Nhóm tin liên quan  

C0ng gi� ng nh�  ch�  �� , nhóm tin liên quan cho phép ta có th�  trình bày nhi� u b� n tin 

liên quan – nh� ng trong m� t ph
 m vi nh+ h
 n. nhóm tin liên quan giúp truy� n t� i cho ng�� i 

�� c khi xem chi ti� t m� t bài vi� t thành h�  th� ng nh� ng s�  ki� n chuyên bi� t, ví d� : Chùm s�  

ki� n v�  bão l� t mi� n Trung.  

*�  qu� n lý các nhóm tin liên quan c0ng t�
 ng t�  nh�  qu� n lý các ch�  �� .  

 

* Các block tin  

Ph� n này giúp cho chúng ta h�� ng �� i t�� ng ng�� i �� c chú ý h
 n �� n nh� ng bài vi� t 

��� c thêm vào nh$m làm n	 i b� t m� t hay nhi� u bài vi� t.  

Trong ph� n qu� n lý bài vi� t cho chúng ta 02 l� a ch� n: - Tin tiêu � i� m – Tin m� i nh� t  

1 

2 

3 
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* Ngu� n tin  

* ây là ph� n khai báo ��  �� a vào bài vi� t ��� c trích d(n t% ngu� n nào bao g� m: Tên 

ngu� n và �� a ch  liên k� t t� i ngu� n tin � ó.  

Ta có th�  thêm nhi� u ngu� n tin b$ng cách nh� p �� y ��  thông tin vào ph� n  

 

* C	 u hình module  

Ph� n c� u hình module giúp chúng ta tùy ch nh cách hi� n th� bài vi� t, hình � nh, s�  l�� ng 

liên k� t và m� t s�  ch� c n"ng khác cho module Tin t� c.  

Trong ph� n này chúng ta có các l� a ch� n:  

- Ph�
 ng án th�  hi� n t
 i trang ch� : C0ng gi� ng nh�  Cách th�  hi� n ch�  ��  ph� n này cho 

chúng ta 06 l� a ch� n nh�  danh sách, m� i lên trên,…  

- Kích th�� c c� a hình t
 i trang ch� : Là kích th�� c t� i � a v�  chi� u r� ng ho! c chi� u dài t
 i 

hình minh h� a c� a bài vi� t khi xem t
 i trang ch�  hay vào m� t ch�  ��  - m� t chuyên m� c. *
 n 

v� tính b$ng Pixel  

- Kích th�� c hình minh h� a t
 i block: Nh�  �  ph� n qu� n lý các block chúng ta cho phép 

l� a ch� n m� t hay nhi� u bài vi� t vào m� t trong 02 block tin nóng ho! c tin m� i, ph� n này cho 
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phép chúng ta quy �� nh kích th�� c c� a hình minh h� a cho bài vi� t thu� c block � ó. *
 n v� tính 

b$ng Pixel.  

- Kích th�� c c� a hình d�� i ph� n m�  �� u c� a bài vi� t: Cho phép chúng ta ch  �� nh kích 

th�� c t� i � a c� a hình minh h� a cho bài vi� t khi ch� c n"ng này ��� c kích ho
 t �  menu Thêm 

bài vi� t.  

S�  bài vi� t ��� c hi� n th� cùng v� i ph� n gi� i thi� u ng)n g� n trên m� t trang: Cho phép 

chúng ta c� u hình trên m� t trang chuyên m� c hay m� t trang ch�  ��  có t� i � a bao nhiêu bài 

vi� t ��� c hi� n th�.  

- S�  bài vi� t ch  hi� n th� link: Cho phép c� u hình s�  liên k� t �� n các bài vi� t liên quan 

cùng chuyên m� c, cùng ch�  ��  khi xem chi ti� t m� t bài vi� t.  

- Th� o lu� n m! c �� nh khi thêm bài vi� t m� i: Cho phép xét th� o lu� n cho t%ng �� i t�� ng 

chung – m! c �� nh cho t� t c�  bài vi� t.  

- T�  �� ng �" ng th� o lu� n không thông qua ki� m duy� t: Khi ch� n ch� c n"ng này ng�� i 

�� c s'  th� y ph� n th� o lu� n c� a mình ngay khi �" ng th� o lu� n. N� u b+ ch� n ch� c n"ng này, ��  

hi� n th� bình lu� n c� a ng�� i �� c – b
 n c� n ph� i vào menu Qu� n lý bình lu� n ��  cho phép bình 

lu� n c� a ng�� i �� c có th�  hi� n th�.  

- Thông báo b� n quy� n bài vi� t: Ghi chú ý cho ng�� i mu� n �" ng l
 i thông tin bài vi� t 

c� n ph� i tuân th�  nh� ng gì, ch� c n"ng này ��� c kích ho
 t trong t%ng bài vi� t m� t. M! c �� nh 

trong t%ng bài vi� t ch� c n"ng này b� t) t.  

 

* Xu 	 t b� n và s
 a ch� a tin t� c  

- Xu� t b� n tin t� c  

*�  xu� t b� n tin t� c chúng ta nh� n vào menu Thêm bài vi� t trong admin qu� n lý Tin t� c, 

��  xu� t b� n m� t b� n tin chúng ta c� n ph� i � i� n thông tin vào 16 b�� c nh�  hình d�� i � ây:  

1. Nh� p vào tiêu ��  bài vi� t (B) t bu� c).  
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2. Ch� n ch�  ��  c� a bài vi� t (B) t bu� c): Bài vi� t có th�  ch� n 1 ho! c nhi� u ch�  ��  liên 

quan.  

3. Ch� n chuyên ��  (Không b) t bu� c).  

4. Hình minh h� a cho ph� n gi� i thi� u (Không b) t bu� c)  

5. Chú thích cho hình minh h� a (Không b) t bu� c).  

6. Hình � nh t
 i bài vi� t: Cung c� p tùy ch� n cách hi� n th� hình � nh, có 03 l� a ch� n: 

Không hi� n th�, hi� n th� m! c �� nh theo c� u hình module và hi� n th� bên d�� i tiêu ��  bài vi� t. 

(Không b) t bu� c, c� u hình m! c �� nh ��� c l� a ch� n: hi� n th� theo c� u hình module).  

7. Gi� i thi� u ng)n g� n (Không b) t bu� c – Khuy� n cáo không nên b+ qua b�� c này.) Có 

tác d� ng miêu t�  chung nh� t n� i dung c� a bài vi� t mu� n truy� n t� i �� n ng�� i �� c. Khi nh� p 

thông tin vào � ây s'  làm cho bài vi� t ��� c trình bày �4p h
 n.  

 

 
8. N� i dung chi ti� t: (B) t bu� c) – Toàn b�  n� i dung c� a bài vi� t s'  ��� c hi� n th� khi b
 n 

� i� n thông tin vào ô này.  

9. Tác gi�  bài vi� t (Không b) t bu� c) – N� u không nh� p thông tin vào, h�  th� ng s'  t�  

�� ng l� y theo tên c� a ng�� i �" ng bài vi� t.  

1 

2 

3 
4 
5 

6 

7 

8 

9 

10 

11 

12 

13 

14 
15 
16 
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10. Ngu� n tin (Không b) t bu� c) – Có th�  l� a ch� n trong danh sách � ã t
 o �  m� c Ngu� n 

tin bên trên ho! c n� u ngu� n tin ch� a có trong danh sách thì có th�  nh� p vào ô tr� ng �  bên 

d�� i.  

11. Gi�  b� n quy� n bài vi� t (Không b) t bu� c) – M! c �� nh ch�  ��  gi�  b� n quy� n bài vi� t 

s'  ��� c t�  �� ng ch� n, n� u bài vi� t không ph� i do các b
 n t�  biên so
 n thì có th�  b+ l� a ch� n 

�  ô này. Khi ch�  ��  này ��� c kích ho
 t m&i khi xem bài vi� t � ó d�� i bài vi� t s'  có thêm dòng 

b� n quy� n tác gi� . 

12. T% khóa dành cho máy ch�  tìm ki� m: Nh$m m� c � ích t� i � u hóa bài vi� t v� i th# 

keyword dành cho b�  máy tìm ki� m. N� u ��  tr� ng h�  th� ng s'  t�  �� ng t
 o t% khóa cho bài 

vi� t c� a b
 n, b
 n c0ng có th�  s�  d� ng công c�  ��� c cung c� p s. n b$ng cách copy toàn b�  n� i 

dung bài vi� t và paste vào ô s�  10 – sau � ó nh� n vào nút công c�  Vào � ây ��  t
 o keyword cho 

bài vi� t c� a b
 n. Ho! c b
 n c0ng có th�  t�  nh� p t% khóa – chú ý m&i t% khóa phân cách nhau 

b� i d� u ph1y. (Không b) t bu� c – Khuy� n khích dùng n� u các b
 n chú tr� ng �� n v� n ��  t� i � u 

hóa bài vi� t cho b�  máy tìm ki� m).  

13. Quy� n xem bài vi� t: H
 n ch�  1 ho! c nhi� u �� i t�� ng có th�  truy c� p �� n bài vi� t c� a 

b
 n, m! c �� nh h�  th� ng s'  ��  t� t c�  m� i ng�� i có th�  xem. B
 n có th�  c� u hình l
 i b$ng cách 

l� a ch� n m� t trong nh� ng cách ��� c cung c� p:  

- T� t c�   

- Thành viên  

- Khách  

- Qu� n tr�  

- Ho! c m� t trong nh� ng nhóm trong Menu qu� n tr� Nhóm do b
 n t
 o ra (Không b) t 

bu� c).  

14. Th� i gian �" ng: H�  th� ng s'  t�  �� ng �" ng bài vi� t vào th� i gian do b
 n l� a ch� n 

tình theo Ngày – tháng – n"m: Gi�  - Phút. (Không b) t bu� c)  

15. Th� i gian h� t h
 n: H�  th� ng s'  t�  �� ng khóa bài vi� t không cho ng�� i �� c xem vào 

th� i gian mà b
 n quy �� nh bài vi� t h� t hi� u l� c. (Không b) t bu� c).  

16. Tính n"ng m�  r� ng: Cung c� p cho b
 n các l� a ch� n v�  :  

- Hi� n th� trên trang ch�  (M! c �� nh giá tr� l: Có)  

- Cho phép th� o lu� n (M! c �� nh giá tr� là: Thành viên, b
 n c0ng có th�  l� a ch� n các giá 

tr� là Không ho! c là T� t c�  m� i ng�� i �� u có th�  tham gia th� o lu� n).  

- Cho phép x� p h
 ng bài vi� t: Nh$m giúp ng�� i �� c � ánh giá bài vi� t theo các m� c yêu 

thích. M! c �� nh h�  th� ng s'  cho phép ng�� i �� c s�  d� ng ch� c n"ng này.  

- Cho phép g� i bài vi� t: *�  ng�� i �� c có th�  g� i bài vi� t này cho b
 n bè qua email, m! c 

�� nh h�  th� ng luôn b� t ch� c n"ng này.  

- Cho phép in bài vi� t: M! c �� nh h�  th� ng s'  cho phép ng�� i �� c s�  d� ng ch� c n"ng 

này. B
 n có th�  không cho ng�� i �� c s�  d� ng nó b$ng cách b+ l� a ch� n này.  

- Cho phép l� u bài vi� t: Ch� c n"ng này ph� c v�  yêu c� u khi ng�� i �� c có nhu c� u l� u 

tr�  bài vi� t trên máy ��  có th�  �� c l
 i mà không c� n vào website. M! c �� nh h�  th� ng s'  b� t 

tính n"ng này, b
 n có th�  t) t nó b$ng cách b+ l� a ch� n này.  
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Khi � ã hoàn thành 16 b�� c trên b
 n hãy nh� n vào nút L� u thay �	 i ��  xu� t b� n bài vi� t. 

Hãy tr�  l
 i trang ch�  và xem thành qu�  mà b
 n có ��� c.  

* S
 a ch� a – xóa tin t� c  

*�  s�  d� ng ch� c n"ng này b
 n nh� n vào menu qu� n lý Tin t� c (1) nh�  hình  

 
 Sau � ó nhìn sang phía menu bên ph� i, t�
 ng � ng v� i m&i bài vi� t �� u có menu l� a ch� n 

v� i 02 ch� c n"ng � ó là: S� a – Xóa. *�  s� a bài vi� t nào b
 n hãy nh� n vào menu S� a (2) �  bài 

vi� t � ó.  

 

1 

2 

1 

2 

3 
4 
5 

6 

7 
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13 

14 
15 
16 

17 
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Khi m� t bài vi� t ��� c ch� n ��  s� a s'  nh�  hình minh h� a d�� i:  

Các b�� c t% 1-16 t�
 ng t�  nh�  khi thêm bài vi� t 

 
17: Liên k� t t�nh: T
 o liên k� t thân thi� n cho b�  máy tìm ki� m, giúp bài vi� t c� a b
 n �
 t 

th�  h
 ng tìm ki� m cao. M! c �� nh h�  th� ng s'  t�  t
 o ra liên k� t t�nh cho b
 n, n� u mu� n thay 

�	 i b
 n có th�  ch nh s� a t
 i m� c “liên k� t t�nh” (17)  

c. Qu� n lý giao di� n 

 
Sau khi cài �! t thành công h�  th� ng CMS c� a NukeViet chúng ta � ã có s. n 2 giao di� n 

nh�  trên, ��  l� a ch� n giao di� n nào cho h�  th� ng ta kích ho
 t giao di� n � ó, toàn b�  các file, 

hình � nh ..v.v. c� a b�  giao di� n ��� c �! t trong th�  m� c quy �� nh cho tên c� a t%ng giao di� n. 

*�  cài �
 t thêm giao di� n cho h�  th� ng ta có th�  t� i các themes t% trang web c� a 

NukeViet theo �� a ch  http://nukeviet.vn/vi/download/Themes . Sau khi t� i v�  ch� n m� c “Cài 


� t theme” ��  cài �! t theme m� i. 

 
Trong h� p l� a ch� n cài �! t ta ch� n m� c “Cài �! t theme lên h�  th� ng” r� i ch� n nút “Ti� p 

t� c” ��  chy� n sang b�� c ti� p theo. 
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Ch� n nút “Browse…” r� i ch� n ��� ng d(n �� n file zip c� a theme v%a t� i v� , nh� n ch� n 

nút “Ti� p t� c” ��  h�  th� ng ti� n hành cài �! t theme. 

Ta th� y h�  th� ng � ã c� p nh� t thêm theme m� i (HTGROUP), ��  s�  d� ng ��� c theme này 

cho h�  th� ng ta c� n thi� t l� p layout cho theme m� i này. 

 
Thi� t l� p layout 
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d, Qu� n lý Block 
Block là các kh� i thi� t l� p nên giao di� n cho t%ng theme khác nhau, ta có th�  l� a ch� n 

��� c th�  t�  và v� trí hi� n th� c� a t%ng block trên website. 

 
*�  thi� t l� p th�  t�  hi� n th� và v� trí c� a t%ng block tr�� c h� t ta ph� i ch� n module mà 

mình mu� n thi� t l� p 

 
V� trí hi� n th� c� a block bao g� m: HEADER = *� u trang; BOTTOM = Cu� i trang; 

TOP= *� u trang; LEFT= Bên trái; RIGHT=Bên ph� i …v.v. 

e, Qu� n lý Module 
M&i module là m� t l�nh v� c khác nhau, �� m nhi� m m� t ch� c n"ng trên trang web. 

Trong h�  th� ng NukeViet cho phép ta có th�  tùy bi� n, thêm m� i, s� a, xóa ho! c cài �! t l
 i 

t%ng module. 

T�
 ng t�  nh�  Block, ta có th�  t� i thêm module t% trang nukeviet.vn ��  cài �! t lên h�  

th� ng website c� a mình (các b�� c cài �� t t�� ng t�  nh�  Block). 

 

------ * ------ 
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PH� N II  

WEBDESIGN 

THI � T K � , XÂY D	 NG K CH B� N WEB 

VÀ CÁC THÀNH PH � N C! A WEBSITE 
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I. K "ch b� n web là gì? T#i sao ph� i xây d� ng k"ch b� n web? 
a, K	ch b� n web 

K�ch b� n web là b� n thi� t k�  ban �� u c� a website ch  th�  hi� n bao g� m b�  c� c, màu s)c, 

các thành ph� n s'  có trong website, không c� n �! c t�  rõ là website s'  ��� c thi� t k�  b$ng ngôn 

ng�  gì, s�  d� ng database nào và các ch� c n"ng c� a t%ng thành ph� n ho
 t �� ng nh�  th�  nào. 

b, T� i sao ph� i xây d� ng k	ch b� n web? 
M� t website c0ng ��� c coi là m� t h�  th� ng thông tin qu� n lý và ph� i �� m bào ��� c t� t 

c�  các yêu c� u �! t ra �� i v� i m� t h�  th� ng thông tin. *� i v� i m� t h�  th� ng thông tin b� t k�  

�� u ��� c phát tri� n và t� n t
 i tuân theo vòng phát tri� n c� a h�  th� ng nh�  s
  ��  d�� i � ây. 

 

 

 

 

 

 

 

 

 

 

 

 

 

*� i v� i xây d� ng m� t website ta có th�  mô t�  c�  th�  theo s
  d�  d� i � ây 

 

 

 

 

 

 

 

 

 

 

 

 

 

H�  th� ng c�  � ang ho� t 
� � ng nh�  th�  nào? 

Xác �	 nh yêu c
 u c� a 
h�  th� ng m� i ph
 i làm 

Phân tích, thi� t k� , xây 
d� ng h�  th� ng m� i 

Cài �� t, ch� y th� , phát 
hi� n l� i c� a h�  th� ng 

Th�  gi� i 
logic 

Th�  gi� i 
th� c 

K
ý 

k�
t 

h�
p 

��
ng

 

G� p g� , thu th� p thông 
tin t�  ng� � i yêu c
 u 

Xác �	 nh yêu c
 u c� a h�  
th� ng website 

Phân tích, thi� t k� , xây 
d� ng website 

Pulish, ch� y th� , phát 
hi� n l� i c� a webisite 

Công tác 
chu� n b	 

Th� c 
hi� n 

1 

2 

4 3 
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Vì v� y, ��  � i �� n th+a thu� n và ký h� p �� ng xây d� ng website thì b�� c 2 là b�� c quan 

tr� ng tr�� c tiên (b�� c này còn g� i là xây d� ng d�  án ti� n kh�  thi). *� i v� i m� t website thì 

b�� c này c� n �! c t�  ��� c các ch� c n"ng c� a h�  th� ng, b�  c� c, giao di� n, màu s)c c� a website 

.v.v. *�  th�  hi� n ��� c nh� ng y� u t�  trên yêu c� u c� n ph� i thi� t k�  k�ch b� n web. 

L� i ích: 

- Th�  hi� n ngay ��� c website d�� i d
 ng hình � nh 

- S�  d� ng hình � nh và màu s)c t% k�ch b� n khi xây d� ng website (tránh ph� i ch"nh 

s� a theo ý ki� n c
 a ng�� i yêu c� u xây d� ng website sau này) 

- Làm c"n c�  ��  ký k� t h� p �� ng xây d� ng website 

II. Thi � t k�  k"ch b� n web (Web Desgin) 
T� t c�  các bài t� p trong giáo trình này tác gi�  s�  d� ng ph� n m� m Adobe Photoshop CS 

Version 8.0 ��  minh h� a. 

Bài 1: Thi� t k�  trang Intro 

 
S�  d� ng hình � nh P2-1.JPG trong �� a CD ho! c hình � nh khác ��  thay th� . 

B�� c 1: T% c� a s	  màn hình Photoshop tao m� t 

file m� i: File -> New v� i kích th�� c r� ng 1024 

pixels và dài 768 pixesl (Preset Sizes:1024 x 

768); Color Mode: RBG Color; Ch� n Ok ��  

ch� p nh� n. 

 

 

B�� c 2: Ch� n nut OK ��  t
 o m� t file m� i v� i các thông tin � ã thi� t l� p �  b�� c 1 

B�� c 3: Hi� n th� thanh th�� c d� c và th�� c nganh c� a file: View -> Rulers 
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B�� c 5: Thi� t l� p vùng ch� n v� i kích th�� c r� ng 25cm, cao 2cm t
 i v� trí th�� c ngang � i� m 

5cm và th�� c d� c � i� m 4cm, click ch� n lên b� n v' , ch� n Layer->New->Layer via Copy 

 

B�� c 4: ��  màu n� n 

c� a toàn file là màu 

� en 
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B�� c 7: Gi�  phím Ctrl r� i click trên Layer 1 ��  ch� n toàn b� p Layer r� i kéo vùng ch� n 

xu� ng d�� i (khi kéo gi% phím shift ��  gi% nguyên v� trí theo th�� c ngang) t
 o thành m� t 

khung m� i có kích th�� c b$ng khung m(u trên layer 1, �	  màu cho khung m� i t
 o nh�  hình 

d�� i � ây. 

 
B�� c 8: Ch� n m� t vùng nh+ trong ph� n m� i t
 o nh�  hình d�� i � ây 

    

B�� c 6: ��  màu 

cho toàn b�  Layer 

m� i t� o ra (Layer 1) 

là màu �	  
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B�� c 9: Ch� n màu và t
 o Gradent cho vùng ch� n nh�  hình d�� i � ây 

 
B�� c 10: Chon Edit -> Stoke: Width=1; Color=Black; Location=Center ��  thi� t l� p vi� n cho 

2 ph� n phân cách trên 

 
B�� c 11: T
 o thêm Layer 2 ch  có thanh màu �+  phía trên nh�  sau 

- Ch� n Layer -> New -> Layer Via Copy 

 
B�� c 12: Thi� t l� p ch�  ��  hi� n 

th� cho Layer 2 

- Click � úp chu� t lên 

Layer 2 ho! c ch� n 

ph� i chu� t -> 

Blending Option 

- Thi� t l� p thông s�  nh�  

hình d�� i � ây 
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B�� c 13: Chèn hình � nh vào v� trí ngay trên layer Backgroud nh�  hình d�� i � ây, hi� u ch nh 

l
 i kích th�� c hình � nh và c) t b+ ph� n th%a bên ngoài.  

 
B�� c 14: Ch� n và t
 o ��� ng vi� n phía trong khung cho hình � nh 

- Ch� n kh� i c� n t
 p vi� n (theo kh	 i ch� n nét �� t) 

- Ch� n Edit – Storke và thi� t l� p thông s�  nh�  hình v' . 

  
B�� c 15: Thay �	 i kênh màu cho hình � nh: ch� n Layer 3, ch� n Images -> Adjustments -> 

Color Balance và thi� t l� p thông s�  theo hình d�� i � ây 
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B�� c 16: T
 o m� t layer m� i (Layer 4), s�  d� ng công c�  v'  (Brush Tool) ��  v'  thêm ��� ng 

k# trang trí 

- Layer -> New -> Layer (1) 

- Ch� n và thi� t l� p thông s�  cho 

Brush Toll (2) 

 

  

 

 

 

 

 

 

 

 

- K# 3 ��� ng th2ng lên Layer 4 (khi v'  gi�  phím Shift ��  v'  ��� c ��� ng th2ng) 

 
B�� c 17: Ch� n Layer 3 trong danh sách Layer và ch� n kh� i theo hình v' , thay �	 i �� n sáng 

t� i c� a kh� i: Image -> Ajustments -> Brightness/Contrast (Brightness=60; Contrast=0). 

  
 

 

 

1 

2 
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B�� c 18: T
 o nút Main: T
 o m� t Layer m� i có tên Layer 5 

- V'  m� t hình tròn vào v� trí mu� n t
 o 

- S�  d� ng Gradent Tool ��  �	  màu 

 
B�� c 19: Ch$n v"n b� n (ch�  “Main”) vào trong nút, �� nh d
 ng v"n b� n và thi� t l� p thu� c tính 

bóng cho ch�  main 

 

  
B�� c 20: Nh� p và �� nh d
 ng các v"n b� n, ch� n File -> Save As For Web ��  xu� t b� n 
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Bài 2: Thi� t k�  trang gi� i thi � u s� n ph� m 

 
S�  d� ng hình � nh P2-2.JPG, P2-2a.JPG trong � ãi CD kèm theo giáo trình 

B�� c 1: T
 o m� t file m� i v� i kích th�� c 1024 x 768 pixels: File -> New 

B�� c 2: Ch� n m� t vùng t
 i v� trí 

0:1,5 cm v� i kích th�� c 

height=1cm, width=28cm 

B�� c 3: T
 o m� t layer m� i (Layer 

1): Layer -> New Layer; ch� n màu 

và �	  màu cho vùng ch� n trên 

Layer 1 

B�� c 4: Thi� t l� p Single Culomn 

Marquee Tool t
 i các v� trí 2,5cm; 

6cm; 8,5cm; 12cm; 14,5cm, 20cm 

r� i xáo (nh� n phím Delete) ��  t
 o 

thành các ��� ng phân cách 

B�� c 5: Chèn hình � nh P2-2.JPG 

t% �� a CD vào file hi� n t
 i thành 

Layer 2, s�  d� ng công c�  Free 

Transform ��  ch nh kích th�� c c� a 

anh trên Layer 2 b$ng v� i Layer 1 

(thay �� i v� trí sao cho Layer 1 $ trên Layer 2). 

- Thay �	 i v� trí hi� n th� hình � nh c� a Layer 2 lên trên hình � nh c� a 

Layer 1  
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B�� c 6:  

Chèn dòng ch�  “Timberland”:  

- Font: Impact 

- Size:30pt 

- Font color:# 865112 

+ Chuy� n ki�  text c� a Timberland 

thành Layer: Layer -> Rasterize -> 

Layer 

B�� c 7: Thi�  l� p thu� c tính 

Smooth cho “Timberland”: Ch� n 

vi� n c� a kh� i ch� , Select -> 

Modify -> Smooth 

B�� c 8: Xóa vùng ngoài ��  t
 o 

vi� n cho ch�  “Timberland”: 

- B� m t	  h� p phìm Ctrl + Shift + I 

��  ch� n vùng ngoài c� a ch� , nh� n 

phím Delete ��  xóa vùng ngoài, 

b� m Ctrl + D ��  h� y cùng ch� n. 

B�� c 9: T
 o các ch�  cho menu  

 
B�� c 10: Chèn hình � nh ph� n thân d�� i menu (P2-2a.JPG) và hoàn thi� n 
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Bài 3: Thi� t k�  m� t m� u website thông tin 

 
- Bài t� p này s�  d� ng các hình anh: P2-3.jpg; P2-3a.jpg; P2-3b.jpg; P2-3b2.jpg; P2-3b3.jpg; 

P2-3b4.jpg; P2-3b5.jpg trong  �� a CD 

B�� c 1: T
 o m� t file m� i v� i kích th�� c 1024 x 768:  Width=1024 pixels; Height=768 pixels 

B�� c 2: Ch� n m� t vùng trên b� n v'  t% v� trí 4 cm �� n v� trí 31cm c� a thanh th�� c ngang v� i 

chi� u cao 4cm, ch� n màu n� n là # 

9D080D r� i �	  màu cho vùng 

ch� n. 

B�� c 3: Ch� n m� t vùng t
 i v� trí 

4cm trên th�� c ngang và 0,5cm 

trên th�� c d� c có kích th�� c r� ng  27cm và cao 1,5cm. T
 o m� t Layer 

m� i (Layer 1) v� i cùng kích th�� c � ã ch� n: Layer -> New -> Layer Via 

Copy 
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B�� c 4: Ch� n màu và t
 o Grandent 

cho Layer 1: 

- Foreground color: # 1DCD32 

- Background color: # 145A0F 

 

 

 

B�� c 5: Ch� n ti� p vùng d�� i c� a 

hình trên Layer 1 � ã t
 o m� t vùng 

ch� n có kích th�� c r� ng 27cm, cao 

0,5cm t
 i v� trí th�� c d� c là 2cm, th�� c ngày là 4cm. 

B�� c 6: *	  màu # 1DCD32 cho 

kh� i � ã ch� n (tr%ng v� i màu c� a 

Foreground �  b�� c 4), nh� n t	  h� p 

phím Ctrl + D ��  thoát kh+i ch�  ��  � ánh d� u vùng ch� n. 

B�� c 7: S�  d� ng công c�  Single 

Column Maquee Tool ��  � ánh d� u 

ch� n t
 i các v� trí 8cm; 12cm; 

16cm; 20cm; 24cm; 28cm. 

Nh� n phím Delete ��  xóa các v� trí 

� ã ch� n t
 o thành các ��� ng phân 

cách t
 i các v� trí � ó. 

B�� c 8: T
 o bóng cho Layer 2 

 

B�� c 9: Ch� n m� t vùng t
 o v� trí 24cm �� n  v� trí 31cm trên th�� c ngang và cao h� t chi� u 

cao c� a b� n v' , �	  màu cùng v� i màu n� n c� a Layer Background (hình bên trái), ph� n còn l
 i 

�	  màu #640407 (hình bên ph� i). 
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B�� c 10: T
 o Layer 2 ��  thi� t k�  ��� ng viên 2 bên c� a trang: Layer -> New -> Layer; ch� n 

kh� i ��  thi� t l� p vi� n có chi� u cao b$ng toàn b�  b� n v'  (768 pixels) và ��  r� ng là 0,5cm; t
 o 

Grandent cho kh� i ch� n nh�  hình v'  (1); gi�  phím Alt + Shift r� i kéo kh� i bên trái sang bên 

ph� i ��  t
 o ��� ng bên ph� i cho b� n v'  (2). 

 

B�� c 11: Chèn hình � nh P2-3.JPG 

vào b� n v' : File -> Open, ch� n 

��� ng �� n file P2-3.JPG (trong �#a 

CD). Kéo vào b� n v'  ��  t
 o thành 

Layer 3 r� i s�  d� ng Free Transform 

��  � i� u ch nh kích th�� c và �� a 

vào v� trí nh�  hình v' ; ch� n thu� c 

tính Linear Light cho Layer 3. 

 

 

 

 

 

1 2 Gi�  Alt + Shift r� i kéo 
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B�� c 12: Thay �	 i Levels cho hình � nh trên Layer 3: Images -> Adjustements -> Levels 

      

B�� c 13: T
 o thêm Layer m� i 

(Layer 4) ��  thi� t k�  vùng v"n b� n: 

Layer -> New -> Layer; trên Layer 

4 ch� n kh� i r� i �	  màu cho 2 ô ��  

có ��� c nh�  hình v'  sau:  

 

 

 

 

 

 

B�� c 14: M�  và chèn hình � nh  

P2-3a.JPG vào b� n v'  (t� o thành 

Layer 5-�� t layer 5 sau layer 1); 

thi� t l� p thu� c tính cho layer 5 là 

Vivid Light 

 
B�� c 15: Ch� n ki� u ch� , font ch� , màu ch� , kích th�� c ch�  cho phù h� p r� i s�  d� ng công c�  

Type Tool ��  nh� p v"n b� n cho k�ch b� n ta se ��� c k�ch b� n nh�  ��  bài (trang 45). 



 50 

III. C $t nh% và xu� t b� n hình � nh cho web 
Trong ph� n này ta s�  d� ng k�ch b� n th�  3 (bài 3) $ trên ��  th� c hi� n 

       

 

 

 

B�� c 2: S�  d� ng thanh th�� c d� c 

và th�� c ngang kéo vào hình � nh ��  

t
 o ra các ��� ng phân cách cho 

t%ng kh� i hình � nh 

Ph� n �  d�  khi �� a vào trang 

web s'  là n� i dung c� a m&i trang 

khi ta biên t� p bài vi� t do v� y ph� n 

này không ph� i là thành ph� n t�nh, 

ta xóa tr)ng và không l� u thành 

hình � nh. 

 

 

 

B�� c 3: Ch� n t%ng vùng tùy theo 

b�  c� c mà mình �� nh xây d� ng cho 

website ��  c) t hình � nh và l� u l
 i 

thành các � nh thành ph� n (ph� i 

�� m b� o là các � nh thành ph� n 

ghép l� i s�  ��� c m� t kh	 i nguyên 

v&n nh�  m� u ban �� u). 

Background.jpg; Banner.jpg; 

CenterBorder.jpg; LeftBorder.jpg; 

Menu.jpg; MidleLine.jpg; 

RightBorder.jpg. 

 

B�� c 1: Sau khi hoàn 

thành vi� c thi� t k�  

k�ch b� n cho web ta 

hòa nh� p t� t c�  các 

Layer thành 1 layer r� i 

m� i ti � n hành c) t nh�  

hình � nh (có th�  b! m 

t�  h� p phím 

Shift+Ctrl+E). 
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B�� c 4: T
 o m� t th�  m� c web và th�  m� c Images trong th�  m� c web (web\Images), copy 

toàn b�  các hình � nh vào th�  m� c Images. 

B�� c 5: M�  Macromedia Dreamweaver MX, t
 o m� t site �� n th�  m� c � ã t
 o �  b�� c 4, s�  

d� ng table ��  t
 o khuôn m(u, chèn các hình � nh vào v� trí nh�  hình d�� i � ây 

  
Thi� t l� p vi� n và kho� ng cách gi� a các ô �� u b$ng 0 ��  không còn ��� ng phân cách 

gi� a các �� i t�� ng ta s'  ��� c trang web nh�  sau: 
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BÀI T � P ÁP DUNG: THI � T K �  K� CH B� N WEB THEO M � U SAU 
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IV. Thi � t k�  � nh �� ng v� i Easy Gif Animator 

PH� N M� M EASY GIF ANIMATOR 
 

1. Gi� i thi� u  

Ph
 n m� m Easy GIF Animator giúp cho ng�� i s
  d� ng có th�  d�  dàng t� o ra 

��� c các hình � nh �� ng, chuy� n �� i � an xem gi� a nhi� u hình � nh khác nhau, 

t� o hi� u � ng chuy� n �� ng c� a �� i t�� ng bao g� m c�  hình � nh và v� n b� n. S� n 

ph� m c� a ph
 n m� m cho phép ta xu� t ra ��� c hình � nh �� ng d� ng file GIF 

(*.GIF) ho� c file Flash script (*.SWF). 

1.1- T� i v�  và cài �� t ph� n m� m 

·  T� i ph
 n m� m t�  Internet theo �� a ch� web: 

http://www.blumentals.net/download/ 

·  Sau khi t� i ph
 n m� m v�  máy tính chay file cài �� t (fiel egifan4p.exe). 

L� a ch n các thông s�  cài �� t mà ch�! ng trình �� a ra (ho� c nh� n Next liên 

t� c ��  ch� p nh"n thông s�  m� c �� nh) cho �#n khi k#t thúc quá trình cài �� t 

2. H�� ng d� n s�  d� ng 

Sau khi cài �� t ta kh$i �� ng ch�! ng 

trình nh�  sau: 

Start/Programs/Easy GIF Animator/ 

Easy GIF Animator 

 
Trong � ó: 

Easy Wizards 

-. Create New Animation: T� o m� t �� i t�� ng �� ng m� i theo t� ng b�� c, sau 

khi hoàn thi� n có th�  l� u l� i d�� i d� ng � nh GIF ho� c file Flash video 
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- Creatr Animated Banner: T� o m� t �� i t�� ng là m� t banner (th�� ng dùng 

cho website, tuy nhiên v�  kích th�� c khác nhau thì có th�  s
  d� ng cho nh� ng 

m� c � ích khác nhau). 

- Create Animated Button: T� o m� t nút có hi� u � ng m� i 

General Tasks 

- Create New Blank Animation: T� o m� t �� i t�� ng �� ng tr� ng m� i 

- Open Existing Animation: M$ m� t �� i t�� ng �� ng � ã có 

2.1 - S
  d� ng công c�  Wizards 

��  s
  d� ng t� o m� t �� i t�� ng 

�� ng b%ng công c�  wizards ta ch n 

m� t trong ba �� i t�� ng trong nhóm 

Easy Wizards r� i th� c hi� n theo các 

b�� c sau: 

- B1: Ch n các hình � nh ��  hi� n th� 

cho �� i t�� ng Add Images -> Next 

- B2: Thi#t l"p ch# ��  l� p và th� i gian 

l� p l� i s�  hi� n th� c� a các hình � nh 

 

 

- B3: Ch n v� trí hi� n th� c� a hình � nh 

+ Top left conner of the frame: 

Hi� n th� $ góc trên bên trái khung 

hình � nh 

+ Center in the frame: & gi� a 

khung hi� n th� hình � nh 
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+ Resize to fit: Ch�nh kích th�� c hình � nh b%ng khung hi� n th� hình � nh 

+ Nh� n Finish ��  k#t thúc. Sau khi k#t thúc ch# ��  t� o m� t �� i t�� ng �� ng 

b%ng công c�  Wizards ch�! ng trình s'  m$ ra c
 a s�  thi#t k# 

 

2.2 - T
 o và ch�nh s
 a các �� i t �� ng 

2.2.1 - Thanh công c�  chu� n 

 
  1   2      3   4    5   6    7    8  9   10  11  12 

1. T� o m� i m� t �� i t�� ng �� ng 

2. M�  m� t �� i t�� ng � ã có 

3. L� u �� i t�� ng hi	 n th
 i 

4. L� u t� t c�  các �� i t�� ng 

5. Quay tr�  l� i thao tác tr�� c 

6.Th
 c hi	 n thao tác k�  ti� p 

7. C� t �� i t�� ng � ang ch� n 

8. Copy �� i t�� ng � ang ch� n 

9. Dán �� i t�� ng � ang ch� n 

10. Th
 c thi các ho� t �� ng 

11. Th
 c thi các ho� t �� ng t� i 
c� a s�  m� i 

Thanh công c�  chu1n 

C� a s	  hi� n th� chính 

Thanh công c�  v'  

C� a s	  thu� c tính 

Các �� i t�� ng và các công c�  
làm vi� c v� i �� i t�� ng (Frame) 
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12.Th
 c thi �� i t�� ng b� ng trình duy	 t web

2.2.2 - Các thao tác �� i v� i Frame 

+  Insert Image: Chèn hình � nh 

+  Insert Bliank Frame: Chèn m� t 
Frame r( ng 

+  Delete: Xóa frame hi� n th� i 
+  Duplicate Frame: Nhân � ôi frame 

hi� n th� i. 

+  Edit frame: S
 a frame b%ng Paint 
 

 

 

 

2.2.3- Thi#t l"p thu� c tính, hi� u � ng cho �� i t�� ng 

* ��  thi#t l"p hi� u � ng cho �� i t�� ng: ch n �� i 

t�� ng mu� n thi#t l"p hi� u � ng -> ch n menu Tools -

> Create Image Effect. 

 
 
 
 
 

 

 

 

 

 

 

Ki � u hi� u � ng 

T� c ��  th� c hi� n 

T� c ��  th� c hi� n 
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Sau khi thi#t l"p hi� u � ng cho m� t �� i t�� ng, bên 

khung danh sách Frame s'  t� o ra các frame li� n k�  

nhau ��  hi� n th� cho vi� c chuy� n hi� u � ng c� a �� i 

t�� ng � ó. 

* ��  t� o ch�  (v� n b� n) cho �� i t�� ng và hi� u � ng 

cho v� n b� n: ch n �� i t�� ng mu� n thi#t l"p hi� u � ng 

-> ch n menu Tools -> Create Animation Text. 

 

Trang � ó: 

- How to Appear: là ho� t �� ng khi hi� n th� v� n b� n 

- How long to show: là th� i gian hi� n th� v� n b� n (tính b%ng gi� y) 

- How to hide: là ho� t �� ng khi � n v� n b� n kh	 i hình � nh 
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3. Xu	 t b� n �� i t �� ng 

Sau khi hoàn thi� n ch n menu File, ph
 n m� m có th�  cho phép l� u l� i d�� i 3 

d� ng: Video - Export to AVI (*.AVI), Flash video script - Export to Flash 

(*.SWF) và � nh �� ng - Export All Frames (*.GIF). 

V. Thi � t k�  �� i t&' ng Flash v� i Sothink Swf  Easy 

PH� N M� M SOTHINK SWF EASY Sothink SWF 
Easy 

1. Gi� i thi � u  

Ph
 n m� m Sothink SWF Easy cho phép ng�� i s
  d� ng có th�  d�  dàng t� o ra 

��� c các file Flash video script bao g� m c�  hình � nh và âm thanh, file Flash 

video script ��� c úng d� ng r� t nhi� u trong l)nh v� c CNTT �� c bi� t là s
  d� ng 

cho vi� c trình chi#u và website.  

��  t� o m� t hình � nh �� ng b� n có th�  s
  d� ng các hình � nh t)nh có s*n, s
  

d� ng công c�  v'  c� a ph
 n m� m, chèn v� n b� n, chèn các file âm thanh, video, 

clip phim, nút, th"m chí c�  m� t video cript flash và sau � ó thay �� i v� trí, hành 

dáng, màu s+c, kích th�� c ..v.v ��  �� t ��� c nhu c
 u c� a mình. Ngoài ra b� n có 

th�  nhúng các mã � i� u khi� n ho� t �� ng (Action Script) ��  có ��� c các ch� c 

n� ng cao h! n n#u mu� n. Giao di� n tr� c quan và cho phép xem th
  k#t qu�  thi#t 

k# trong khi � ang th� c hi� n mà khân c
 n xu� t b� n thành s� n ph� m. 

Sothink SWF Easy cho b� n ba lo� i m, u �� i t�� ng tr�� c khi th� c hi� n 

(Album, Banner, các nút � i� u khi� n) và th�  vi� n các m, u có sãn cho các �� i 

t�� ng này ��  l� a ch n cho t� ng lo� i. V� i các m, u có s*n, b� n có th�  d�  dàng t� o 

ra hình � nh �� ng chuyên nghi� p Flash b%ng cách s
  d� ng th�  vi� n các hi� u � ng 

(Effect) chuy� n �� ng mà ng�� i thi#t k# không c
 n t� n nhi� u th� i gian và công 

s� c ��  t� o ra nó. 

Các ki� u �� nh d� ng file c� a Sothink SWF Easy 

Các ki� u file c� a Sothink SWF Easy 

- GLA: SWF Easy file tài li� u 
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- GLS: SWF Easy Shape file 

- GLB: file SWF Easy Button 

- GLM: SWF Easy Movie Clip file 

H(  tr�  các d� ng file khác nh� : 

- Các d� ng file hình � nh: BMP, JPG, PNG, GIF 

- H(  tr�  ��  h a vector 

- Các d� ng file âm thanh: MP3, WAV 

- Các d� ng file video: mpg, mpeg, wmv, asf, mov, qt, rm, rmvb, mp4, 
m1v, m2v, vob và 3gp 

1.2 T� i v�  và cài �� t ph� n m� m 

·  T� i v�  t�  Internet: http://www.sothink.com/product/swfeasy/index.htm 

·  Sau khi t� i ph
 n m� m v�  máy tính ta ti#n hành gi� i nén file swfeasy.zip 

b%ng ph
 n m� m winzip, winRAR ho� c các ch�! ng trình gi� i nén khác, 

ch� y file setup.exe ��  ti#n hành cài �� t ph
 n m� m và l� a ch n các yêu 

c
 u c� a ch�! ng trình cài �� t cho �#n khi quá trình cài �� t k#t thúc. 

2. H�� ng d� n s�  d	 ng ph
 n m� m 

Start/Programs /Source Tec/Sothink SWF Easy/Sothink SWF Easy 

 

 

Thanh menu Thanh công c�  (Tools bar) 

Scene 
panel 

Timeline 

Stage 
Resource & 
Component 

Properties 
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2.1 - Thanh menu 

Thanh menu là thanh n%m ngang trên �
 u c
 a s�  c� a ch�! ng trình g� m các 

l� nh File, Edit, View, Insert, Modify, Tools, Help. 

Trong m( i menu trên bao g� m các menu con ��  th� c hi� n các l� nh t�! ng 

� ng �� i v� i m( i ch� c n� ng trong nhóm 

2.2 – Thanh công c�  chu� n (Tools bar) 

 

Thanh công c�  chu� n g� m các bi� u t�� ng, � ng v� i m( i bi� u t�� ng � ó khi 

click chu� t s'  th� c hi� n các ch� c n� ng khác nhau 

- New   l� nh new cho phép ta t� o ra m� t file m� i, trong l� nh new cho 

phép ta có 2 l� a ch n: New File (Ctrl + N) dùng ��  t� o m� t file m� i tr� ng, New 

From Template cho phép ta t� o m� t file m� i theo các m, u có s*n. 

- Open   l� nh open ��  m$ file có s*n (file *.GLA) trên máy tính, nh� n 

vào m- i tên x�  xu� ng s'  cho ta m$ ngay các file m� i làm vi� c g
 n � ây. 

- Save   l� nh save ��  l� u file d�� i d� ng *.GLA 

- Import   l� nh import cho phép ta nh"p các file âm thanh, hình � nh, video 

và file swf vào ch�! ng trình � ang làm vi� c 

- Cut   l� nh cút dùng ��  c+t b	  �� i t�� ng ��� c l� a ch n mà v, n l� u trong 

b�  nh�  t� m ��  n#u c
 n có th�  dán l� i t� i v� trí khác n#u mu� n 

- Copy   l� nh copy dùng ��  sao chép �� i t�� ng ��� c l� a ch n vào b�  

nh�  t� m ��  có th�  dán t� i v� trí khác n#u mu� n. 

- Past   l� nh past ��  dán �� i t�� ng t�  b�  nh�  t� m vào v� trí l� a ch n 

- Undo  l� nh undo ��  quay l� i thao tác � ã th� c hi� n tr�� c 
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- Redo  l� nh redo ��  th� c hi� n thao tác k# ti#p, l� nh này ch� th� c hi� n 

��� c n#u hi� n t� i không ph� i là thao tác cu� i cùng. 

- Transform  l� nh này ��  ch n, di chuy� n, thay �� i kích th�� c, soay chi� u 

..v.v các �� i t�� ng 

- Reshape  công c�  l� a ch n và thay �� i hình d� ng c� a �� i t�� ng theo 

t� ng � o� n nh	 . 

- Công c�  v'   các công c�  cho phép ta v'  các �� i t�� ng, 

v� n b� n. 

- Nhóm �� i t�� ng xu� t b� n  bao g� m: chay th
 , ch� y b%ng 

trình duy� t, xu� t b� n thành file swf, publish lên website. 

2.3 – T� o � ng d� ng nh�  công c�  wizart và các m� u có s� n 

��  t� o m� t � ng d� ng nh�  công c�  wizart và các m, u có s*n c� a ch�! ng 

trình ta ch n menu File/New Form Template 

Ph
 n m� m h(  tr�  cho ta ba m, u có 

s*n: 

- Album: t� o th�  vi� n � nh t�  m� t 

nhóm hình � nh � ã có theo m, u có s*n 

- Banner: t� o m� t banner �� ng 

theo m, u có s*n 

- Navigation Buttons: t� o các nút 

l� nh th� c hi� n ch� c n� ng theo m, u. 

Bài t"p 1: T� o m� t Album � nh t�  nh� ng hình � nh � ã có: 

B1: Ch n menu File/New From Template 

B2: Ch n m� c Album r� i ch n nút OK 
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B3: Ch n ki� u hi� n th� c� a Album (Normal) 

B4: Ch n m, u Album r� i nh, n nút 

Next 

 

 

 

B5: Ch n các hình � nh cho Album 

Nh� n nút Next 2 l
 n r� i ch n th�  

m� c ��  xu� t b� n file Album và k#t 

thúc ch n nút Finish, ch�! ng trình s'  

t� o cho ta ��� c m� t � ng d� ng v�  

Album � nh theo các thông tin � ã l� a ch n 

 

 

Bài t"p 2: T� o m� t � ng d� ng anh �� ng b%ng wizard 

B1: Ch n menu File/New From Template 



 63 

B2: Ch n m� c Banner r� i ch n nút OK 

B3: Ch n m, u có s*n 

 

 

 

 

 

 

B4: Thi#t l"p các thông s�  mà 

ch�! ng trình yêu c
 u nh� : chi� u cao, 

chi� u r� ng, � nh n� n, v� n b� n hi� n th� 

…v., k#t thúc nh� n nút Finish 

 

2.4 – T� o m� i, thêm các �� i t�
 ng vào ch�� ng trình 

Sothink SWF Easy cho phép b� n s
  d� ng các �� i t�� ng có s*n trong máy 

tính ho� c t�  t� o ra các �� i t�� ng nh�  công c�  v'  c� a ch�! ng trình. 

* T� o m� i �� i t�� ng trong Sothink SWF Easy 

S
  d� ng các công c�  v'   ��  

t� o các �� i t�� ng ��  h a và s
  d� ng công c�   Reshape ��  

ch�nh s
 a hình d� ng c� a �� i t�� ng.  

 

* Chèn các �� i t�� ng có s*n 

��  chèn (Import) �� i t�� ng hình � nh, âm thanh, video, file swf vào ch�! ng 

trình ta có th�  s
  d� ng 2 cách sau: 
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+ Cách 1: Ch n menu File/Import, ch n �# n �� i t�� ng c
 n import r� i ch n 

Open, �� i t�� ng ��� c ch n s'  l"p t� c 

��� c �� a vào Stage � ang làm vi� c. 

+ Cách 2: Chon menu Insert sau 

� ó ch n ki� u c� a �� i t�� ng mu� n 

chèn vào Stage nh�  hình � nh, âm 

thanh, video 

* S
  d� ng công c�  Transform ��  

ch�nh s
 a �� i t�� ng: công c�  Transform cho phép thay �� i kích c. , xoay và 

nghiêng �� i t�� ng tùy thu� c vào hình thái hi� n th� c� a con tr	  

khi �� a chu� t �# n t� ng v� trí khác nhau 

- Khi con tr	  có hình  là b� n có th�  xoay �� i t�� ng 

 

- Khi con tr	  có hình  là b� n có th�  thay �� i kích th�� c 

c� a �� i t�� ng 

- Khi con tr	  có hình  là b� n có th�  xoay chéo �� i 

t�� ng theo trung � i� m 

- Khi con tr	  có hình  là b� n có th�  thay �� i v� trí 

c� a m� t � i� m 

* Chèn v� n b� n 

��  chèn v� n b� n vào �� i t�� ng c� a mình b� n ch n 

 trên thanh công c�  r� i kéo chu� t ��  khoanh vùng v� n 

b� n sau � ó nh"p � o� n v� n b� n c
 n chèn.  
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��  �� nh d� ng cho v� n b� n ta thay �� i các thu� c tính c� a v� n b� n trong ph
 n 

Properties. 

2.5 T� o hi� u � ng (Effect) cho �� i t�
 ng 

��  t� o hi� u � ng cho �� i t�� ng ta 

ch n �� i t�� ng r� i ch n nút Add 

Effect 

- Entrance: hi� u � ng th� c hi� n khi 

�� i t�� ng xu� t hi� n. 

- Emphasics: hi� u � ng th� c hi� n 

khi �� i t�� ng � ã xu� t hi� n 

- Exit: Hi� u � ng th� c hi� n khi � n 

�� i t�� ng 

- Motion Path: T� o chuy� n �� ng 

c� a �� i t�� ng theo m� t qu/  �� o nh� t 

�� nh. 

Sau khi ch n nhóm hi� u � ng s'  xu� t 

hi� n menu danh sách các hi� u � ng, 

khi di chuy� n con tr	  chu� t t� i hi� u 

� ng ta s'  nhìn ��� c m, u v�  ki� u th�  

hi� n c� a hi� u � ng ��� c th�  hi� n ngay bên c� nh hi� u � ng � ó. 

��  hi� n th� ��� c hi� u � ng c� a �� i t�� ng b%ng chính s�  th�  hi� n c� a �� i 

t�� ng � ó ta ch n �� i t�� ng r� i ch n nút Add Effect, ch n Select 

Trong c
 a s�  select effect, m( i khi ch n m� t hi� u � ng trong danh sách ta có 

th�  nhìn th� y s�  th�  hi� n c� a �� i t�� ng � ó cùng v� i hi� u � ng trong c
 a s�  

Preview. 
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Sau khi � ã thi#t l"p m� t hi� u � ng cho �� i t�� ng, hi� u � ng � ó s'  ��� c th�  

hi� n tên hi� u � ng và th� i gian th� c 

hi� n c� a hi� u � ng t� i vùng Timeline 

theo d� ng frame và th� i gian th� c hi� n ��� c tính b%ng giây. 

��  di chuy� n, thay �� i th�  t�  th� c hi� n c� a �� i t�� ng ta click và gi�  trái 

chu� t lên hi� u � ng � ó r� i di chuy� n 

��  thay �� i th� i gian th� c hi� n 

hi� u � ng ta di chuy� n chu� t �#n v� trí 

frame �
 u tiên ho� c cu� i cùng c� a 

hi� u � ng sau � ó click và gi�  trái chu� t r� i di chuy� n. 

Sau khi hoàn thành vi� c l� a ch n 

và ch�nh s
 a hi� u � ng ta khóa hi� u 

� ng b%ng cách click chu� t ��  � ánh d� u check loock cho hi� u � ng 

Cùng tron m� c t� o hi� u � ng cho 

�� i t�� ng ta có th�  thi#t l"p chuy� n 

�� ng cho �� i t�� ng theo m� t qu/  �� o 

nào � ó b%ng cách: ch n Add 

Effect/Motion Path r� i thi#t l"p qu/  

�� o chuy� n �� ng cho �� i t�� ng. 

2.6 Xu� t b� n � ng d� ng 

Sothink SWF Easy có th�  xu� t b� n thành m� t file video flash (*.swf), xu� t 

b� n thành file video flash �� ng th� i chèn code vào trang web ho� c ch� hi� n th� 

� o� n code ��  chèn file video flash vào web mà không xu� t b� n ra file video 

flash. 
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��  xu� t b� n s� n ph� m ch n menu File/Publish ho� c ch n nút Publish  

trên thanh công c� . 

- Xu� t b� n thành file video flash 

(*.swf) ch n m� c 1, nh� n nút Next, 

ch n ��� ng d, n t� i th�  m� c l� u ch�  

s� n ph� m ho� c nh� n nút Browse, nh� n 

nút Fnish ��  hoàn t� t vi� c xu� t b� n 

s� n ph� m. 
 

- Xu� t b� n thành file video flash và �� ng th� i chèn code HTML vào trang 

web (��  th
 c hi	 n thao tác này tr�� c tiên ta ph� i có trang web HTML, ASP, 

PHP …v.v tr�� c khi xu� t b� n s� n ph� m) ch n m� c 2, nh� n nút Next, ch n thông 

s�  thi#t l"p ��  t� o ra mã code khi chèn vào trang web, nh� n nút Next ��  chuy� n 

�#n b�� c ti#p theo, ch n �#n th�  m� c và trang web s'  ��� c chèn code khi xu� t 

b� n, ch n v� trí chèn code vào n� i dung trang web r� i nh� n nút Insert. 

Nh� n ch n nút Next ��  xác th� c vi� c chèn code vào trang web r� i ch n nút 

Finish ��  k#t thúc quá trình xu� t b� n s� n ph� m. 
 

- Xu� t b� n s� n ph� m nh� ng ch� hi� n 

th� code HTML ��  chèn �� i t�� ng 

video flash vào trang web mà không 

t� o ra filde video flash ta ch n m� c 3, 

$ thao tác này ta có th�  nhìn th� y � o� n 

code và các thu� c tính thi#t l"p cho 

file video flash khi chèn m� t file video 

flash vào trang web ��  có th�  copy 

� o� n code này s
  d� ng vào m� c � ích c� a mình. 

1 

2 

3 



 68 

M� C L� C 
 

PH0 N I – XÂY D1 NG WEBSITE B2 NG NUKEVIET .................................... 1 
I: M3 T S4  KHÁI NI 5M & CÀI �6 T CH78 NG TRÌNH ................................. 2 
1. M� t s�  khái ni� m ............................................................................................... 2 

a, Web page ........................................................................................................ 2 
b, Website .......................................................................................................... 2 
c, HTML (Hyper Text Markup Language) ........................................................ 2 
d, Th9 HTML (Tag) ........................................................................................... 2 

2. C� u trúc c!  b� n c� a trang web .......................................................................... 3 
3. T� i, cài �� t và thi#t l"p website trên Macromedia Dreamweaver ..................... 3 

a, T� i, cài �� t Macromedia Dreamweaver ......................................................... 3 
b, Thi#t l"p website trên Dreamweaver MX 2004 ............................................ 4 

II: THI : T K:  TRANG WEB T;NH ..................................................................... 7 
1. Thi#t k# c� u trúc website ................................................................................... 7 
2. Xây d� ng m� t trang web �! n gi� n .................................................................... 9 

a, T� o b� ng trong trang web .............................................................................. 9 
* Thu� c tính c� a b� ng .................................................................................... 9 
* Thu� c tính c� a ô ........................................................................................ 10 
* Tr� n (hòa nh"p) các ô ................................................................................ 10 
* Tách m� t ô thành nhi� u ô .......................................................................... 10 

b. �� nh d� ng v� n b� n ....................................................................................... 11 
c. T� o liên k#t cho �� i t�� ng trong trang web ................................................. 11 
d. Chèn hình � nh vào trang web ...................................................................... 12 

* Thu� c tính c� a hình � nh ............................................................................ 12 
e, Chèn âm thanh, video, flash vào trang web ................................................. 13 
f, Xây d� ng website �! n gi� n .......................................................................... 13 

III: S<  D=NG FTP FILEZILA CLIENT ........................................................... 14 
1. T� i và cài �� t Ftp FileZila Client .................................................................... 14 
2. Truy c"p t� i FTP b%ng FTP FileZila Client .................................................... 14 
3. T� i website lên hosting .................................................................................... 15 
IV: CÀI �6 T, S<  D=NG VÀ QU> N TR? NUKEVIET .................................. 16 
1. Vertrigo ........................................................................................................... 17 

a, Gi� i thi� u...................................................................................................... 17 
b, Cài �� t .......................................................................................................... 18 

2. NukeViet ......................................................................................................... 19 
a, T� i và cài �� t NukeViet ............................................................................... 19 
b, H�� ng d, n qu� n tr� tin t� c ........................................................................... 23 

* Ch�  ��  và qu� n lý ch�  ��  tin t� c ............................................................... 23 



 69 

* Nhóm tin liên quan .................................................................................... 26 
* Các block tin .............................................................................................. 26 
* Ngu� n tin ................................................................................................... 27 
* C� u hình module ....................................................................................... 27 
* Xu� t b� n và s
 a ch� a tin t� c ..................................................................... 28 
* S
 a ch� a – xóa tin t� c ............................................................................... 31 

c. Qu� n lý giao di� n ......................................................................................... 32 
d, Qu� n lý Block .............................................................................................. 34 
e, Qu� n lý Module ........................................................................................... 34 

PH0 N II- WEBDESIGN .................................................................................... 35 
I. K�ch b� n web là gì? T� i sao ph� i xây d� ng k�ch b� n web? ............................. 36 

a, K�ch b� n web ............................................................................................... 36 
b, T� i sao ph� i xây d� ng k�ch b� n web? .......................................................... 36 

II. Thi#t k# k�ch b� n web (Web Desgin) ............................................................. 37 
Bài 1: Thi#t k# trang Intro ............................................................................... 37 
Bài 2: Thi#t k# trang gi� i thi� u s� n ph� m ........................................................ 44 
Bài 3: Thi#t k# m� t m, u website thông tin ...................................................... 46 

III. C+t nh	  và xu� t b� n hình � nh cho web ......................................................... 50 
IV. Thi#t k# � nh �� ng v� i Easy Gif Animator .................................................... 53 
PH0 N M@M EASY GIF ANIMATOR .............................................................. 53 

1. Gi� i thi� u .................................................................................................. 53 
1.1- T� i v�  và cài �� t ph� n m� m ............................................................... 53 

2. H�� ng d, n s
  d� ng ................................................................................... 53 
2.1 - S
  d� ng công c�  Wizards .................................................................... 54 
2.2 - T� o và ch�nh s
 a các �� i t�� ng ........................................................... 55 
3. Xu� t b� n �� i t�� ng ................................................................................... 58 

V. Thi#t k# �� i t�� ng Flash v� i Sothink Swf  Easy ........................................... 58 
PH0 N M@M SOTHINK SWF EASY ................................................................ 58 
Sothink SWF Easy .............................................................................................. 58 

1. Gi� i thi � u ................................................................................................. 58 
1.2 T� i v�  và cài �� t ph
 n m� m ....................................................................... 59 
2. H�� ng d� n s�  d	 ng ph
 n m� m ............................................................. 59 
2.1 - Thanh menu ............................................................................................. 60 
2.2 – Thanh công c�  chu� n (Tools bar) ........................................................... 60 
2.3 – T� o � ng d� ng nh�  công c�  wizart và các m, u có s*n ............................ 61 
2.4 – T� o m� i, thêm các �� i t�� ng vào ch�! ng trình ..................................... 63 
2.5 T� o hi� u � ng (Effect) cho �� i t�� ng ......................................................... 65 
2.6 Xu� t b� n � ng d� ng ..................................................................................... 66 

 


